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Introduction

Introduction XE "Introduction" 
TeleTiger NT is a Telephone Cost Management System (TCMS), sometimes called a Call Accounting System (CAS).

Your company’s private telephone exchange (PABX) sends basic information to TeleTiger NT about telephone calls that have been made. TeleTiger NT calculates additional information — such as the cost of the calls and to whom they should be charged — and places the data in a database. 

The database can be interrogated by TeleTiger to produce reports and screen-displays showing the usage of your telephone exchange.

Features XE "Features" 
 True 32-bit Windows program.

 Millennium XE "Millennium compliance"  (Y2K XE "Y2K" ) compliant.

 Multi-user and network friendly.

 Bilingual in Arabic and English.

 Dual calendar support (Hijri and Gregorian).

 Works with any modern telephone exchange.

 User defined reports XE "User defined reports"  (requires Crystal Reports report designer) .

 Telephone exchange SMDR fault monitoring.

 Automatic starting from power-down.

 Easy integration with other third-party software.

 Non-proprietary database engine.

System Requirements XE "System Requirements" 
TeleTiger is designed to run on any fairly recent standard PC, typically a Pentium II with 32Mb of memory, a 1.2Gb hard disk and at least one unused serial (COM) port.

If call-traffic XE "call-traffic"  is very high or the number of telephone extensions is large (in excess of 500) then a more powerful PC will provide faster performance. If in doubt, you should consult your TeleTiger dealer

If call-traffic is very low or the number of telephone extensions is small (less than 50) then a less powerful PC may be adequate. If in doubt, you should consult your TeleTiger dealer.

TeleTiger is designed to run under Microsoft Windows NT XE "Windows NT"  Workstation. 

Although TeleTiger will run under any 32-bit Windows operating system, such as Windows 95 XE "Windows 95"  or Windows 98 XE "Windows 98" , you should remember that Windows NT is more robust and is the operating system that Microsoft recommends for real-time data-logging systems like TeleTiger NT. 

	Caution  If your PC ‘hangs’ and your PABX does not provide proper data-buffering (many do not) then data may be lost until the PC is re-booted. Windows NT is much less likely to do this as it better at encapsulating and controlling any faulty or badly designed third-party programs you may try to run at the same time as TeleTiger NT 


Important  Notes XE "Important  Notes" 
Please make sure that you read this section in its entirety, even if you read nothing else in this manual.

PABX Accuracy XE "PABX Accuracy" 
TeleTiger depends entirely upon the accuracy of the data sent by your telephone exchange (PABX). 

Although TeleTiger may be operating with 100% accuracy XE "accuracy" , if your PABX sends faulty or incomplete data, then this will adversely affect the accuracy of the entire system. For instance, if your PABX is unable to report call-connection status properly, then TeleTiger will be forced to guess this (perhaps incorrectly) from the call duration.

	Tip  TeleTiger can keep a complete record of all raw data XE "raw data"  sent by the PABX. If it is suspected that the PABX is sending bad data, then this record can be examined and brought to the attention of the company or department responsible for PABX maintenance, so that the problem can be corrected


Back-up XE "Back-up" 
All computer equipment will eventually fail. This is especially true of hard-disks. It is not a matter of if your hard-disk will fail, but when. 

When your hard-disk inevitably fails, it is possible that you will not be able to recover any of the data on it. All telephone call data and other information on it may be irretrievably lost.

This risk applies to all computer systems, not just to TeleTiger. You could just as easily lose your company’s accounting records or other valuable data.

Unless you are prepared to risk and perhaps tolerate the loss of all your data, then you should make regular back-ups. There are plenty of products available on the market for backing-up to diskettes, tape-drives, ‘floptical’ drives, CD’s and so forth. 

	Tip Most versions of Windows already include a simple utility for backing-up data to diskettes XE "diskettes"  or tape drive XE "tape drive" . See your Windows manual for details. 


Viruses XE "Viruses" 
Viruses are less of a problem these days since most hi-tech vandals now consider virus development highly unfashionable and instead direct their efforts towards breaking Internet security. However there are still a lot of old viruses (and a few new ones) around.

To avoid the destruction of your system and data by viruses, you should take a number of basic precautions:

 Do not use pirate software XE "pirate software" .

 Get a good virus checker. Use and update it regularly.

 Do not put unknown diskettes in the PC without scanning them with a virus checker. 

	Tip You can obtain evaluation copies of virus-checking software over the Internet at no cost from  www.mcafee XE "mcafee" .com and other sites.  If you decide to purchase your evaluation copy, you can usually arrange to have the virus signature file updated automatically over the Internet XE "Internet" .


Legal Requirements XE "Legal Requirements" 
There may be certain legal requirements for Hotels XE "Hotels" , Compounds XE "Compounds" , Call-cabins XE "Call-cabins" , Hospitals XE "Hospitals"  or other companies and organizations who make charges to employees or the general public for making or attempting to make telephone calls. These legal requirements may change from time to time.

Although Zedan has made every effort to ensure that TeleTiger NT is in compliance with all known and published legal requirements and official recommendations applying in the countries in which it is sold, no guarantee can be given in this respect and it remains the sole duty of the user to ensure legal compliance.

Zedan does not condone and will not support any attempt to misconfigure TeleTiger NT in such a way as to overcharge or otherwise defraud, or to deliberately misrepresent telephone call durations or other data, or to flaunt the requirements and recommendations of any properly constituted authority, nor will Zedan engineers assist customers in this respect. 

Chapter 1 — Basic Concepts
Basic Concepts XE "Basic Concepts" 
Your PABX XE "Your PABX" 
Your company telephone exchange is commonly known in the telecommunications industry as a PABX XE "PABX" . This term is derived from Private Automatic Branch eXchange. An older term sometimes heard is PBX . (They were not always automatic).

SMDR Output to a Printer XE "SMDR Output to a Printer" 
Most modern PABX’s have a socket on the side into which a printer can be plugged. 

Each time a telephone call is completed, a signal is sent to the printer, which then prints out basic information about the call.

This information is known as SMDR data. This term is derived from Station Message Detail Record. An alternative term sometimes heard is CDR data, derived from Call Detail Record. 

A single printed  SMDR line may look something like this:

01/12/1999 12:30PM 123 00441711234567 00:10:30 T0001

From left-to-right, this data means that:

 The call was made on the 1st of December, 1999.

 The call was made at 12:30 p.m.

 The extension used was extension 123

 The number dialed was 00441711234567

 The duration of the call was ten minutes, thirty seconds.

 The trunk line used was trunk line number one.

If you had a printer attached to your PABX before you obtained TeleTiger NT, then you are probably already familiar with SMDR data.

Not all SMDR data is in the format shown above. There is no standard for SMDR format and there are very wide variations, even between PABX’s of apparently identical model and manufacture.

Most SMDR data is relatively easy to read as it was originally designed to be printed on paper to be read by the human eye, but there are exceptions. The same telephone call illustrated above, when made on a different brand of PABX, may produce the following line of printed data:

@1999120112300123---00441711234567630001

This SMDR line has exactly the same meaning, but is less ‘user-friendly’.

There are many hundreds of different formats of SMDR from different PABX vendors and from different models of PABX.

 Some PABX’s have more or less fixed SMDR formats, whilst others can have their SMDR formats altered by programming. TeleTiger NT can be configured to work with almost any format of SMDR, so long as it contains the basic required data.

Telephone Cost Management Systems XE "Telephone Cost Management Systems" 
The above lines of SMDR data are better than nothing, but they are not particularly useful for allocating telephone call charges. A lot of desirable data, such as the cost of the call and the owner of the telephone extension, is not present.

To obtain better results, it is necessary to replace the simple printer with a software system that can perform sophisticated calculations and look-up information in internal tables. Such a system is known as a TCMS (from Telephone Cost Management System) , or a CAS XE "CAS"  (from Call Accounting System XE "Call Accounting System" ).

TeleTiger NT is a TCMS.

SMDR Output to TeleTiger NT XE "SMDR Output to TeleTiger NT" 
The cable XE "cable"  that went from the PABX to the printer is now plugged instead into a PC running the TeleTiger NT software.

The cable is plugged into a serial port (sometimes called a COM port) on the PC. This is the same kind of port that is used to attach a modem, or sometimes a mouse, to the PC. Most PC’s have two serial ports XE "serial ports" , known as COM:1 and COM:2. The cable can be plugged into any COM port, but there must of course be an unused port available. 

The PABX now sends data to the PC instead of to the printer

The Port Buffer XE "Port Buffer"  Software Module

As well as the TeleTiger NT software itself, a second Zedan software module called Port Buffer is installed on your PC when you install a TeleTiger NT system.

Port Buffer is a small and very robust program that accepts the SMDR data coming in to the serial port of the PC from the PABX, and places this into a temporary file for later processing.

So that no call information is lost, it is essential that Port Buffer runs at all times. For that reason, Port Buffer starts automatically when the PC boots-up and it is not possible for a casual user to stop the Port Buffer program by normal means.

The main TeleTiger NT program processes the information collected by Port Buffer. It is not essential that TeleTiger NT runs at all times and it can be started and terminated like any other Windows program.

How TeleTiger Processes the SMDR Data

The SMDR data contains basic information about the telephone call. TeleTiger NT stores the raw SMDR data line, splits it up into the required parts and also derives additional information. Most of this information is obtained by looking-up information in Look-up Tables XE "Look-up Tables" .

Additional derived information includes the following:

Ignore the call? XE "Ignore the call?" 
TeleTiger NT can be configured to ignore certain trunk lines or extensions. 

A company president may wish to monitor and control telephone use within his company, but might not want information about the use of his personal telephone extension or dedicated trunk line to be recorded.

The first thing TeleTiger does with an SMDR record is to look up the trunk line in the Trunks to Ignore XE "Trunks to Ignore"  look-up table and the physical extension in the Physical extensions to ignore XE "Physical extensions to ignore"  look-up table. If the call is found in either table, then no further action is taken and the call is not processed — however the raw SMDR data is retained.

Charge Point XE "Charge Point" 
A Charge Point is the point to which an individual telephone call is charged. 

In a simply configured TeleTiger system, the Charge Point would be the same as the physical extension number, i.e. all telephone calls made on extension 123 would be charged to extension 123.

	Tip The following Charge Point allocation methods are optional. Although you should read the whole of this section, you may wish to leave TeleTiger NT in its basic configuration until you have become more familiar with TCMS’s. 


Since a call may be transferred, the person who dialed the call may not always be the appropriate party to bear the charge. If a telephone attendant or secretary using extension 123 dials a call and then transfers it to a manager on extension 234, then the proper Charge Point would be 234, although the physical extension is 123. TeleTiger NT can do this automatically, provided that attendant and secretarial extensions are defined in the Physical extensions look-up table.

Some PABX’s allow the use of PIN’s XE "PIN’s"  (Personal Identification Numbers XE "Personal Identification Numbers" ). A PIN is a special secret number that can be dialed on any telephone extension to (for example) obtain an outside line.  If an individual employee has a special PIN number, it might be more convenient to charge all calls that he makes using that PIN number to the same Charge Point, regardless of the physical extension used. TeleTiger NT can do this easily — and of course a record of the actual physical extension used is also maintained. In this case, the Charge Point and the physical extension number would not be the same.

PIN numbers are useful, as an employee could (for instance) be given different PIN numbers for personal calls and business calls, allowing these to be automatically separated, even when the same extension is used for both.

If certain numbers are always dialed by the same employee, then the Charge Point can be assigned on this basis, so that all calls made to that number are charged to the same Charge Point, again regardless of the physical extension used. A partial number can be used here as well as a complete number, so that (for instance) all dialed numbers starting with the same four digits, could be charged to the same Charge Point.

Charge point allocation can also be based upon the physical extension used. For instance, if an executive has two telephone extensions on his desk, then it might be more convenient to charge all calls made from them to the same Charge Point, regardless of which individual extension is used.

Charge Point can be assigned according to any combination of the above factors. For instance, if an employee dials his home number from his own extension, then it is a personal call as he is calling his family at home. If his boss or secretary dials the number, then it is a business call as they are trying to contact the employee himself. TeleTiger NT can be configured to handle this and to allocate the Charge Point automatically.

All of the above functions are controlled via the Cost allocation look-up table.

The value used as a Charge Point can be an actual extension number, or it can be a combination of numbers and letters that do not necessarily match an actual extension. For instance if an employee’s usual physical extension is 123, then it would be possible to assign 123P for personal calls and 123B for business calls.

Via the Charge points look-up table, each Charge Point can be associated with an employee or room name (or number), a department number and a re-namable spare field that can be used for anything you wish  (for instance an employee ID or section name.)  These fields are useful when producing reports, as calls within the same department or section can be grouped together or totaled. 

Since TeleTiger NT is a bilingual system, each of the above fields is available in both English and Arabic, so that (for instance) an employee’s name can be entered in both Arabic and English script for use in Arabic and English reports and screen displays. If a field is only entered in one of the two languages, then that value is used for all reports.

Identity XE "Identity" 

 XE "Identity" 
Via the Identities look-up table, each dialed number can be associated with an identity.  For instance entering 0266521904 and Zedan in the Identities look-up table would ensure that the name Zedan appears in the Identity field of all reports and screen displays every time the number 026651904 appears. 

Partial numbers can be used for identities, so (for instance) all numbers beginning with the same four or five digits could be assigned the same Identity. More than one number can be given the same Identity as of course many organizations have more than one telephone line.

Since TeleTiger NT is a bilingual system, the Identity field is available in both English and Arabic, so that an Identity can be entered in both Arabic and English script for use in Arabic and English reports and screen displays. If the field is only entered in one of the two languages, then that value is used for all reports.

PTT Number XE "PTT Number" 
PABX’s normally report the trunk line used as a simple number, e.g. 01 means trunk line number one. 

Via the Trunk lines look-up table, each trunk line number can be associated with the actual PTT number.  For instance entering 01 and 6651904 in the Trunk Lines look-up table would ensure 6651904 appears in the PTT Number field of all reports and screen displays every time trunk line 01 appears. 

More than one trunk line number XE "trunk line number"  can be associated with the same PTT number if required, e.g. where a single number represents a hunt-group with several physical lines.

Cost XE "Cost" 
Calculating the cost of a call requires several steps. 

First, TeleTiger NT searches the Rates XE "Rates"  look-up table for a matching dialing code. From this table, the destination, cost per minute, call type, call zone and other information is known.

Secondly, the call zone, time of the call and day of the week are used to calculate whether or not the call falls within an off-peak period, and if so, what rate now applies. Where appropriate, off-peak periods based upon Hijri dates are also calculated.

Thirdly, the cost of the call is calculated. Depending upon the type of call, this may be based upon a rate per minute XE "rate per minute"  or second, upon differing rates for different parts of the call, or it may be a fixed charge XE "fixed charge" , regardless of duration.

Fourthly, the User Cost XE "User Cost"  of the call is calculated. Every call has a PTT cost XE "PTT cost" , rate and duration and a User cost, rate and duration. Some organizations, such as hotels, place a percentage mark-up on call cost, or otherwise manipulate rate, cost and duration. This can result in two different charges for the same call:

 That charged to the company by the PTT authority

 That charged to the end-user by the company.

These two charges may be completely different and it is therefore necessary for TeleTiger NT to calculate and maintain records of both for reporting purposes. For instance, a trunk line report modeled on a PTT bill would show the PTT rate and cost, but end-user’s invoice would show the User rate and cost. 

It is also possible to determine the profitability of a system by subtracting one cost form the other.

If no mark-ups XE "mark-ups"  or similar manipulations are applied, then both PTT and User values will be identical.

Connection status XE "Connection status" 
The PABX should report whether a telephone call has connected or whether it is just an attempted call. 

Some exchanges send SMDR records only for calls that have connected and do not send records for attempted calls XE "attempted calls" .

Some exchanges send SMDR records for both connected and attempted calls but distinguish between the two by means of a special mark in the SMDR record.

TeleTiger NT can recognize connection status information XE "connection status information"  from either type.

Unfortunately there are some PABX’s that do not distinguish between connected and attempted calls. This may be due to a defect in the PABX design, a mis-configuration of the PABX software, or it may be that the required signal on the PTT line that tells the PABX whether or not a call has connected is not present. Some PABX’s have not been fitted with the equipment that determines whether a call has connected and classify this as an optional extra.

Such PABX’s send SMDR records for both connected and attempted calls without making any distinction between them. In this case, it is possible for TeleTiger NT to ‘guess’ the connection status based upon the number of digits dialed (if too few digits have been dialed, then it is known that a call can not have connected) or upon the duration of the call. 

Guessing connection status XE "Guessing connection status"  based upon duration is a poor compromise and can never be accurate. For instance, if 30 seconds is set as a cut-off point for local calls, all local calls of more than 30 seconds will be assumed to have connected and all those of less than 30 seconds will be assumed to be only attempted calls. Of course it is entirely possible that a 29-second call could have connected and a 31-second call may be only an attempted call.

The cut-off times for the different classes of call and the minimum number of digits required is set in the Call types XE "Call types"  look-up table.

It is possible that some PABX’s may be able to determine connection status on some trunk lines, but not others. 

Trunk lines upon which connection status is known are termed Supervised trunk lines.

Which trunks are supervised and which are not is defined in the Trunk lines look-up table. If an SMDR record is received from a supervised trunk XE "supervised trunk" , then connection status is known. If an SMDR record is received from an unsupervised trunk XE "unsupervised trunk" , then the values in the Call types look-up table are used to ‘guess’ whether or not a call has connected.

	Caution  If your PABX does not properly report call connection status, then TeleTiger NT can ‘guess’ the status based upon the duration and the number of digits dialed; but remember that this is only a guess and will never be 100% accurate. 

This inaccuracy represents a defect in the PABX and/or trunk line, not in TeleTiger NT. 

The only solution to this problem is to have a PABX that reports connection status properly. 


What TeleTiger NT does with the Derived Information

Once the above additional information has been derived from the basic SMDR data, it is stored in a database.

TeleTiger NT interrogates this database to produce screen displays and printed reports showing the usage of your PABX.

You can also query this database directly from other programs or utilities, such as third-party report generators, building & hotel management systems or accounting systems.

Networking

TeleTiger NT can be run on a single stand-alone PC XE "stand-alone PC" , or on a PC that is on a network. 

If TeleTiger NT is run on a network, then it is not necessary that the main database be on the same PC as TeleTiger NT. If the data is to be shared, then it may be more convenient to keep the main database on a separate server XE "server" . Since Port Buffer places all incoming SMDR data in a temporary file on the local PC, there should be no loss of data if the server becomes temporarily unavailable, or if a network connection goes down. The data will simply be cached on the local PC until the server again becomes available.

With a network, it is possible for any PC on the network (with appropriate permissions and passwords) to access the data, either to print reports via another copy of TeleTiger, or via a third-party program or report generator. This is very useful if you have other software, such as accounting systems or hotel management systems, that can query the TeleTiger database directly.

Where a copy of TeleTiger NT is run on another PC (that is not connected directly to a PABX) for the purpose of administering the system or producing reports, then it is not necessary for that PC to have a copy of Port Buffer installed.

Using remote network access XE "remote network access" , with the appropriate passwords and permissions, it is also possible to access, manipulate, configure and supervise TeleTiger NT and its data from off-site. Such remote access software XE "remote access software"  is available from several third-party vendors.

Chapter 2 — Installing
Installing XE "Installing" 
Installing TeleTiger NT is not the same as installing ordinary software, such as a word-processor. TeleTiger NT needs to be connected to your PABX (company telephone exchange) and there are a number of settings that have to be set to match those used by your PABX.

 Installing TeleTiger NT is not difficult, but you need to work carefully through the  various stages in the correct order.

If you are not familiar with computers generally, you may want to read Chapter 3 — Basic Skills (page 3) before you begin.

Before you begin

Your PC XE "Your PC" 
If you try to install any program on a PC that is faulty, you are simply wasting your time. This is true of any software, not Just TeleTiger NT.

Make sure that your PC is in good order and working properly. Do not forget to check network connections (if any). Make sure that you have the correct printer driver installed and print a test page. Scan the hard disk XE "hard disk"  for bad sectors XE "bad sectors" . If you are not sure how to perform the above tests, please see your Windows manual or the Windows help system for details.

Make sure that Windows NT is properly installed and properly configured. If you have been having problems with the PC or if it has been behaving strangely, you should not even think of beginning to install TeleTiger NT, or indeed any other new software, until the PC has been fixed.

Finally, scan the PC to make sure that it does not have a virus infection XE "virus infection" .

Connecting the PABX to the PC XE "Connecting the PABX to the PC" 
Connect your PABX to the PC using the cable supplied by your TeleTiger NT vendor. Make sure that the cable is properly plugged-in and that the retaining screws are tight. Make sure the cable XE "cable"  is routed in such a way that it is not likely to be damaged. For instance, do not run the cable under a carpet where it can be stepped on. It will only be a matter of time until the cable is short-circuited and perhaps damages the PABX or PC.

The Dongle

Make sure that the dongle provided with TeleTiger NT is screwed firmly into the printer port XE "printer port"  of the PC and that the printer cable is firmly screwed into the back of the dongle.

Remember that the dongle is an essential part of TeleTiger NT and carries vital information. If you lose the dongle, you have basically lost the software and it is unlikely that your TeleTiger NT vendor will replace it unless you buy a whole new system.

Loading the software XE "Loading the software" 
Logging-on XE "Logging-on" 
To install TeleTiger NT, you must be logged-on to Windows NT with Administrator XE "Administrator"  privileges. 

If you are not sure what this means, please see your Microsoft Windows NT manual, or the Windows Help system XE "Windows Help system"  for details.

Copying the files

1. Place the TeleTiger NT CD in your CD drive XE "CD drive" .

2. Close the drive.

3. The TeleTiger NT setup program should start automatically.

4. Follow the instructions.

	Tip  If the TeleTiger NT setup program does not start automatically, it is likely that CD Autostart XE "CD Autostart"  is disabled on your CD drive.  (See the Windows Help system for details)

In this case, press the Start button XE "Start button"  on the Windows Taskbar XE "Taskbar" 

 XE "Windows Taskbar"  and click on Run.

Type e:\setup in the text box marked Open, and press the Enter key. (This is assuming that ‘e’ is the letter of your CD drive. If not, use your own drive letter instead.)


Configuring Port Buffer XE "Configuring Port Buffer" 

 XE "Port Buffer" 
The Port Buffer program that accepts and stores the SMDR XE "SMDR"  data sent by the PABX should start automatically when TeleTiger NT re-boots the PC. If you do not understand what this means, please read Chapter 1 — Basic Concepts in its entirety before you try to proceed further.

Unless you are very lucky, you will need to change some of the settings of Port Buffer to match those of your PABX.

Cancel or ignore any error messages XE "error messages"  that may be present. These are probably due to the fact that Port Buffer is not yet configured correctly.

[image: image82.bmp]If you can not see the Port Buffer program, click its button on the Windows Taskbar.

 How to configure Port Buffer XE "How to configure Port Buffer" 
1. To change the configuration settings of Port Buffer, select Options XE "Options"  from the Tools XE "Tools"  menu. 

[image: image1.png]Setings | Confgution | General | Erortiapping | Akt |
Conmuriation pt
® G Baudiote
|
& i Paiy
© COM3: [None (N) B
- come Detabits:
R
- cows Sop i
© COME: 1 :"
oK Cancel Apply





2. The Options window appears.

3. Any values that you change in the Options window are not applied to the system until you press the OK button. 

To exit from the Options window without applying your settings, press the Cancel button.

If you want to apply your changes without closing the Options window (for example to test their effect), press the Apply button.

The Settings tab

The Settings tab is automatically selected when you first enter the Options window.
Setting the Communication Port XE "Communication Port" 
First, select the communication port into which you have plugged the cable from the PABX.

Most standard PC’s have two communication ports, known as COM1: and COM2: Select the number of the port you have used and press Apply. 

If you get an error message saying that the port you have selected is not available, then it is likely that some other device, such as a modem XE "modem"  or mouse XE "mouse" , is using the port XE "port"  already, or the port does not exist.

You need at least one free communication port to connect your PABX to the PC. If you do not have any communication ports free, then you will need to reconfigure your PC’s hardware before proceeding further.

If you are not sure which port you have plugged the PABX cable XE "PABX cable" 

 XE "cable"  into, you can determine this by trial and error. 

Setting the Communications Parameters XE "Parameters" 

 XE "Communications Parameters" 

 XE "Setting the Communications Parameters" 
Your PABX sends SMDR XE "SMDR"  data out at a certain speed and in a certain way. How it does this is defined by what are known as the Communications Parameters. 

The Communications Parameters consist of four separate settings. These are Baud rate, Parity XE "Parity" , Data bits XE "Data bits"  and Stop bits XE "Stop bits" . 

Baud rate XE "Baud rate"  is a measure of how fast the SMDR information is sent (higher numbers are faster) and the other settings are concerned with how error detection is performed.

It does not greatly matter what communications parameters are used, so long as those set in Port Buffer exactly match those used by the PABX. If they do not match exactly, the PABX and PC will be unable to communicate with each other.

You should be able to find out what communications parameters your PABX uses from your PABX technical manual, or from the company or department that supplied it.

If your PABX had a printer XE "printer"  attached to it before you obtained TeleTiger NT, then the settings on the printer are those that you require and can be found out from the printer manual.

Set the correct values for Baud rate, Parity, Data bits and Stop bits, then press the OK button.
The Configuration tab

Click on the Configuration tab and the Configuration panel appears:

[image: image2.png]Setings  Configwation |  General | Enortiapping | Aleatel |
Handshaking:
[Er— ¥ EnatleDTR
Inbufer sz

32766 | 4
Receive threshold:
i | 7 Discard Nl

Input Length Pariy replace:

P SR =

3 Cancel Aoply





Generally, it should not be necessary to change any of these settings and the default values shown in the panel above should work in almost all circumstances, however the ability to alter these values has been provided in case they are required.

Handshaking

This determines how Port Buffer and your PABX control the flow of data. X-on/X-off means that they send special characters to each other to control the flow of data. RTS/CTS means that they use the RTS and CTS lines in the cable between them to control data flow. Both means that both modes are enabled in Port Buffer and None means that neither is enabled.
Normally set this to Both. Even if your PABX does not use both settings, this will generally be a workable setting. Only turn off one or both types of handshaking if they are causing a problem in communicating with your PABX. See your PABX manual or contact your PABX dealer for details.

	Tip  If you feel you need to vary this setting because you are not receiving data from the PABX, then try setting it to None, but make sure that both the Enable DTR and Enable RTS boxes are ticked. 
If this does not cure the problem, then it is likely to be something else, e.g. a bad cable. Be careful to restore all the settings to the default values before proceeding further, or the situation could become very confused.


In-buffer size

This is the amount of memory reserved on the computer to hold incoming data before it is processed. We recommend that this value always be set to 32766 as this is the optimum value. The ability to change this value has been provided as some customers felt they wanted full control of the interface.

Receive threshold

This is the number of characters that must arrive in the receive buffer before it processes them. We recommend that this value always be set to 1 as this is the optimum value. This means that data is immediately processed. The ability to change this value has been provided as some customers felt they wanted full control of the interface.

Input length

This is the number of characters that must be sent to the output buffer by Port Buffer before it processes them. We recommend that this value always be set to 0 as this is the optimum value. This means that data is immediately sent to the PABX. The ability to change this value has been provided as some customers felt they wanted full control of the interface.

Enable DTR

The DTR line is a line in the cable between the PABX and the Port Buffer. If this box is checked, then a voltage is placed on the DTR line. Most PABX’s need this signal to tell them that Port Buffer is there and is turned on. In the absence of this signal, they may refuse to send any data. If the PABX does not require or use this signal, then generally it does no harm to provide it anyway. We recommend that this box always be checked. The ability to change this value has been provided as some customers felt they wanted full control of the interface.

Enable RTS

The RTS line is a line in the cable between the PABX and the Port Buffer. If RTS/CTS Handshaking (data flow control) is enabled, then Port Buffer turns this line off and on to tell the PABX when it is ready to receive data. That is why this box is disabled if RTS/CTS Handshaking is selected. If you do not enable RTS/CTS Handshaking, then you can change this setting. If this box is checked, then a voltage is placed on the DTR line. Most PABX’s need this signal to tell them that Port Buffer is ready to receive data. In the absence of this signal, they may refuse to send any data. If the PABX does not require or use this signal, then generally it does no harm to provide it anyway. We recommend that this box always be ticked. The ability to change this value has been provided as some customers felt they wanted full control of the interface.

Discard Nulls

If this box is ticked, then any Null characters (ASCII value zero) sent by the PABX will be discarded. Nulls sent by PABX’s very rarely have any meaning, but if the occur in the middle of a data line, they can corrupt the data. We recommend that this box always be ticked. The ability to change this value has been provided as some customers felt they wanted full control of the interface.

Parity replace

If a corrupt character is received from the PABX, i.e. a character that fails a parity check, then it is replaced with the character entered here — usually a question mark. We recommend that this value be set to a question mark. The only reason you may want to change it is if your PABX sends question marks as a normal part of a data line (none do that we know of) and you want to be able to distinguish between question marks sent by the PABX and parity errors. The ability to change this value has been provided as some customers felt they wanted full control of the interface
The General tab

Click on the General tab and the General panel appears:
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Buffer file location

This is the directory where Port Buffer will write the incoming data buffer file. If you change this value, then you must make sure that the TeleTiger option for buffer file location is set to the same directory.
You can not control the name of the buffer file as TeleTiger names it dynamically, depending upon the COM port used. For instance data received on COM1 will go to a non-volatile temporary file called _comm1.txt. Teletiger then renames this temporary file to comm1.txt for processing.
	Tip  Always make sure the Buffer file location is on a local hard disk. If you put it on a network drive and you lose the network connection, Port Buffer will have to store the data in memory until it is restored. If memory overflows, then data can be lost!

Note that the above does not apply to the main database which can be anywhere on the network. If network communication is lost in this case, then data loss is very unlikely as the calls will simply be stored in the buffer file on the local machine until required.


Data line separation

Most PABX’s send data in a printer-friendly format. That is to say, the data  is an ASCII string terminated by a Carriage Return and a Line Feed (ASCII 13 and ASCII 10).

There are a very few PABX systems that send data lines that are not separated in the standard manner. These settings allow Port Buffer to cope with these PABX’s.

Buffer Flush Delay

Some rare types of PABX (mostly Northern Telecom brands) send the CR/LF at the start of the data line, rather than the end. 
Normally, when Port Buffer begins to receive a line of data, it waits until it gets a CR/LF and accepts this as an indication that the PABX has finished sending the complete data line. If the PABX sends the data at the start of the line, then Port Buffer will wait until the next data line is received before outputting the data line. No call will be processed until the next call is received from the PABX. The buffer flush delay is the number of seconds Port Buffer will wait (if no more data is received from the PABX during this interval) before outputting the data line, regardless of whether or not a CR/LF has been received.
The recommended setting here is 10 seconds. 
	Tip  If your PABX sends the CR/LF at the start of the line and  you find data lines are being broken in two, then increase this setting. 

If your PABX sends the CR/LF at the start of the line and  you find two data lines coming joined together, then decrease this setting. 

Do not use a setting that is too low, or all data lines will start

As always, if changing this setting does not fix your problem, set it back to the default value before proceeding with other tests or remedies.


Data lines separated by CR and/or LF character(s)
Normally, this option should be selected. This is the normal standard for practically all telephone exchanges. It will work with CR/LF, CR only or LF only. It will also work with mist unusual combinations (e.g. CR/CR/LF/LF )
Data lines separated by start character

In the very unlikely event that your PABX uses something other than a CR and/or LF to separate data lines, then this option can be selected. Doing so reveals another data entry field:

Start character(s)

If your PABX uses something other than a CR and/or LF to separate data lines (typically an exclamation mark) then you can define that character here.

	Tip  Typically such separation characters appear at the start of a line, or there may be different characters at the start and end of the line.

If the character you want to use appears at the end of a line, you can still define it here.

The line will be broken at the right place and the Buffer Flush delay setting can be used to make sure the data is flushed promptly.


The Error trapping tab

Click on the Error trapping tab and the Error trapping panel appears:
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Ignore these errors

If a communications error occurs, then Port Buffer normally sounds an alarm and the main Port Buffer window appears on screen, i.e. it ‘pops-up’.

There are certain events that may occur that are not really errors. For instance if the DRS line is low, then this is strictly speaking an error — however many PABX’s do not follow strict RS232C protocols and does not use the DRS line. In this case it is desirable to ignore any ‘DRS line low’ error, or the alarm will constantly sound.

The settings shown under Ignore these errors in the above figure are the default settings and will give good results for most PABX’s.

	Tip  It is important to distinguish between genuine communications errors and ‘phantom’ errors due to a PABX’s failure to follow official RS232C guidelines.

Do not use these settings to suppress genuine communications errors, particularly parity errors caused by selecting the wrong parity settings. Genuine errors should be dealt with as soon as possible as they may represent data loss.

The only exception would be if you were prepared to tolerate the error. For instance, a bad card in your PABX may cause occasional framing errors. If you had to wait for spare parts to replace it, you may want to suppress these errors temporarily to stop the alarm constantly sounding.


Pop-up on errors

If a communications error occurs, then Port Buffer normally sounds an alarm and the main Port Buffer window appears on screen, i.e. it ‘pops-up’. Uncheck this box if you want to suppress this behavior.

Expect data within…

If your PABX or other associated equipment fails, it may stop sending data. If you check this box and make a setting of (for instance) 15 minutes, then if no data is received for 15 minutes, Port Buffer will pop-up and sound an alarm.

	Tip  If the alarm sounds, make a test telephone call. If the alarm stops, then it was a false alarm. If it does not, then there is probably a genuine problem. 

This setting is only really effective for busy exchanges that operate 24 hours and 7 days a week. If the PABX is for an office that closes at night, then the alarm will sound as soon as telephone calls stop in the evening. In this case the Match to last week option is better.




Match to last week

If your PABX or other associated equipment fails, it may stop sending data. If you check this box, then Port Buffer will compare the data traffic to last week’s data. For instance, if Port Buffer has not received any data for a while, it will see if this was true of the same time last week. If the traffic pattern is a reasonable match, then it will not sound an alarm. This stops Port Buffer from sounding an alarm at times when it is normal not to have any telephone calls, for instance at night or on days when the office is closed.
The Alcatel tab

Click on the Alcatel tab and the Alcatel panel appears:
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Some brands of Alcatel exchange do not send data on a call-by-call basis. Instead they store the data inside the PABX and download it all upon request.
This panel allows you to configure such an exchange.

File transfer mode

If you have an Alcatel exchange that uses file transfer mode, then you should check this box. 

Do not check this box for any other kind of PABX, or Port Buffer will not work.

Minutes between file transfers

This setting has no effect unless File transfer mode is selected.

This setting is the number of minutes Port Buffer will wait after having made a successful Alcatel file transfer, before attempting another transfer.

Dir

This setting has no effect unless File transfer mode is selected.

The Alcatel PABX will ask for a Dir number before permitting file transfer. Put your Dir number here. If you do not know the number, ask your Alcatel support organization.

Password

This setting has no effect unless File transfer mode is selected.

The Alcatel PABX will ask for a Password before permitting file transfer. Put your Password here. If you do not know the Password, ask your Alcatel support organization.

Service

This setting has no effect unless File transfer mode is selected.

The Alcatel PABX will ask for a Service number before permitting file transfer. Put your Service number here. If you do not know the number, ask your Alcatel support organization.

	Tip  These settings are only for Alcatel exchanges that support file transfer mode.
If you do not have such an exchange, do not select file transfer mode.

If you have an Alcatel exchange and are unsure of its mode, call your alcatel support organization.


Verifying that Port Buffer is properly configured XE "Verifying that Port Buffer is properly configured" 
If Port Buffer is now properly configured and everything is working properly, there should be no red lights XE "red lights"  on the main Port Buffer window and there should be no alarms XE "alarms"  sounding. If this is not the case, then you have made a mistake and entered an incorrect value, or you have a hardware error or corrupt file.

[image: image83.bmp] If all is well, then you should make some test telephone calls. When each call terminates, you should see one or more lines of SMDR data appear in the Port Buffer main window. 

The line of data should be clear and contain information about the call, such as dialed number, extension used etc.

There should be no alarms or red lights.

If the data does not seem clear or complete, or if a red light appears and an alarm sounds, then you have made a mistake and entered an incorrect value, or you have a hardware error or corrupt file.

If all is well, proceed to the next stage.

Configuring XE "Configuring"  TeleTiger

If TeleTiger NT is not running, then please start it. Do this from the Windows Start button in the same way that you would for any other program.

If TeleTiger NT has been reconfigured to turn on Security, then you may need to log-on before proceeding further. (Please see page 3.)

PABX type XE "PABX type" 
If you have not already done so, make a few telephone calls. These should appear properly in the data window of the Port Buffer program (page 3). If you do not see any calls in Port Buffer, then there is no point in proceeding further. You should solve the problem with Port Buffer first 

Since there are many possible variations in the SMDR format XE "SMDR format" , it is necessary to tell TeleTiger NT where the data it requires is to be found in the SMDR data line.

To make this process easier, TeleTiger NT can automatically configure itself for many popular brands of PABX.

 How to configure the PABX type XE "How to configure the PABX type" 
5. Select Run from the Processing menu. 

6. Select Telephone Exchange Data Format from the Tools menu.

7. The Telephone Exchange Data Format XE "Telephone Exchange Data Format"  window appears.

8. [image: image84.bmp]Select your PABX from the list. (If it is not there, ask your TeleTiger vendor to configure it manually for you, or to supply the correct configuration file for your model of PABX.)

9.  Click on the Save button.

10. Select Reprocess calls XE "Reprocess calls"  from the Tools menu

11. Confirm that you want to reprocess calls by clicking on OK.

	Caution  Some PABX’s are available in both US and International models. Although the SMDR format may appear the same at first glance, the US models use US date formatting XE "date formatting" 

 XE "US date formatting"  (month before day) whilst the International models use normal date formatting (day before month). Be very careful to select the correct PABX model. 


[image: image85.bmp]
	Tips An SMDR data sample from the PABX model you have selected is displayed (see below)  Compare this with your actual SMDR data to be sure that it matches. 

If you click once on the PABX name, you can use the Up and Down arrows on your keyboard to scroll quickly through the possible PABX types until you find one that matches.


Verifying that TeleTiger is properly configured XE "Verifying that Port Buffer is properly configured" 
We should now test TeleTiger NT to see if everything is properly configured.

 How to check the configuration XE "How to check the configuration" 
12. Select Calls from the Tables menu.

13. Verify that the Dynamic checkbox XE "Dynamic checkbox"  at the bottom of the Calls Table is checked.

14. Make a number of test telephone calls, carefully noting the duration, extension used, number dialed and so forth.

15. Verify that as each call is terminated, data for it appears in the Calls Table.

16. Verify that the times, dates, durations and so forth are correct.

If there seem to be any errors or discrepancies in the data XE "discrepancies in the data" , then you have made a mistake and entered an incorrect value, or you have a hardware error or corrupt file.
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Chapter 3 — Basic Skills
Basic Skills XE "Basic Skills" 
The Main Screen XE "The Main Screen" 
[image: image87.png]IENEEEE T



To make TeleTiger as easy to use as possible, the generally accepted standard for Windows software has been followed. If you are familiar with the Microsoft Office XE "Microsoft Office"  group of programs (such as Microsoft Word XE "Microsoft Word" ) then you will find the layout of the menus XE "menus"  and toolbar buttons familiar.

If the Main Screen is in Arabic XE "Arabic" , you can switch to English by clicking on the word English XE "English" , visible on the menu bar at the top of the screen.

The Menus XE "Menus" 
Where one letter of a menu command is underlined, then holding down the Alt key and typing that letter on the keyboard has the same effect as clicking on the menu item with the mouse. 

For instance, holding down the Alt key and typing F has the same effect as clicking on the File menu.

Some menus have short-cut keys XE "short-cut keys"  shown to the right of the menu item. For instance, Ctrl-V is shown to the right of Paste. Holding down the Ctrl (Control) key and typing V has the same effect as clicking on Paste. 

Depending upon how TeleTiger is configured and which Window is active, not all of the following menu items may be visible or enabled. For instance, if Security is not enabled, then the Log-on/Log-off menu will not be visible.

	Menu option
	Equivalent Button
	Action

	File, Printer XE "Printer" .
	
	Print selected pages from the current report.

	File, Import XE "Import" .
	
	Import charge rate file.

	File, Exit XE "Exit" .
	
	Exit from the program.

	Edit, Cut XE "Cut" .
	[image: image6.bmp]
	Deletes the current selection and copies it to the clipboard.

	Edit XE "Edit" , Copy XE "Copy" .
	[image: image7.bmp]
	Copies the current selection to the clipboard.

	Edit, Paste XE "Paste" .
	[image: image8.bmp]
	Pastes the contents of the clipboard to the current location.

	Edit, Find XE "Find" .
	[image: image9.bmp]
	Find a record.

	View XE "View" , Show raw data XE "Show raw data" 
	[image: image10.bmp]
	Shows the raw SMDR data window.

	View, Language, Arabic XE "Arabic" 
	[image: image11.bmp]
	Change screen language to Arabic.

	View, Language XE "Language" , English
	[image: image12.bmp]
	Change screen language to English.

	View, Calendar XE "Calendar" 
	
	Change between Hijri and Gregorian calendars.

	View, Status XE "Status"  bar
	
	Hide or show the Status bar

	View, Toolbar XE "Toolbar" 
	
	Hide or show the Toolbar

	Log-on XE "Log-on" 
	[image: image13.bmp]
	Logs-on a new user.

	Log-off XE "Log-off" 
	[image: image14.bmp]
	Logs-off the current user.

	Tables XE "Tables" , Calls XE "Calls" 
	[image: image15.bmp]
	Shows the processed telephone calls.

	Tables, Look-up tables XE "Look-up tables" 
	[image: image16.bmp]
	Look-up Tables selection.

	Reports XE "Reports" 
	[image: image17.bmp]
	Starts the Report Generator.

	Tools XE "Tools" , Events log XE "Events log" 
	
	Shows the Events log

	Tools, Telephone exchange data format XE "Telephone exchange data format" 
	
	Sets the SMDR data format.

	Tools, Reprocess calls XE "Reprocess calls" 
	
	Reprocesses the raw SMDR data.

	Tools, Reapply fixed charges XE "Reapply fixed charges" 
	
	Reapplies fixed monthly charges.

	Tools, Diagnostics XE "Diagnostics" 
	[image: image18.bmp]
	Starts the Remote Diagnostics module.

	Tools, Options XE "Options" 
	
	Change configuration options.

	Processing, Run XE "Run"  
	[image: image19.bmp]
	Starts SMDR data processing.

	Processing, Step XE "Step" 
	[image: image20.bmp]
	Processes a single SMDR record, then stops.

	Processing, Pause XE "Pause" 
	[image: image21.bmp]
	Pauses SMDR processing.

	Processing, Stop XE "Stop" 
	[image: image22.bmp]
	Stops SMDR processing.

	Windows, Tile Horizontally XE "Tile Horizontally" 
	
	Tiles any open windows horizontally.

	Windows, Tile Vertically XE "Tile Vertically" 
	
	Tiles any open windows vertically.

	Windows, Cascade XE "Cascade" 
	
	Cascades any open windows

	Windows, Arrange icons XE "Arrange icons" 
	
	Arranges the icons for any minimized windows.

	[image: image23.bmp]
	[image: image24.bmp]
	Change screen language to Arabic.

	Help XE "Help" , About XE "About" 
	
	Displays the About screen.


The Toolbar XE "Toolbar" 
The Toolbar carries a number of buttons XE "buttons"  that make it easy to carryout commonly used actions with a single click. 

If the Toolbar is not visible, you can make it visible by selecting Toolbar from the View menu.

Many Toolbar buttons have an equivalent menu command, but the Toolbar is more convenient to use, unless you prefer to use the keyboard instead of the mouse.

	Tip  If you are not sure what a Toolbar button does, then move the cursor over the button without clicking. After a few seconds, a ToolTip XE "ToolTip"  label describing the purpose of the button will appear.


Depending upon how TeleTiger is configured and which Window is active, not all of the following toolbar buttons may be visible or enabled. For instance, if Security is not enabled, then the Log-on/Log-off button will not be visible.

	Button
	Equivalent menu option
	Action

	[image: image25.bmp]
	View XE "View" , Language XE "Language" , English XE "English" 
	Change screen language to English.

	[image: image26.bmp]
	View, Language, Arabic XE "Arabic" 
	Change screen language to Arabic.

	[image: image27.bmp]
	View, Show raw data XE "Show raw data" 
	Shows the raw SMDR data window.

	[image: image28.bmp]
	Tables XE "Tables" , Calls XE "Calls" 
	Shows the processed telephone calls.

	[image: image29.bmp]
	Tables XE "Tables" , Look-up Tables XE "Look-up Tables" 
	Shows the Look-up Tables selection window.

	[image: image30.bmp]
	Reports XE "Reports" 
	Starts the Report Generator

	[image: image31.bmp]
	Tools XE "Tools" , Diagnostics XE "Diagnostics" 
	Starts the Remote Diagnostics module.

	[image: image32.bmp]
	Log-off XE "Log-off" 
	Logs-off the current user.

	[image: image33.bmp]
	Log-on XE "Log-on" 
	Logs-on a new user.

	[image: image34.bmp]
	Processing XE "Processing" , Run XE "Run" 
	Starts SMDR data processing.

	[image: image35.bmp]
	Processing, Step XE "Step" 
	Processes a single SMDR record, then stops.

	[image: image36.bmp]
	Processing, Pause XE "Pause" 
	Pauses SMDR processing.

	[image: image37.bmp]
	Processing, Stop XE "Stop" 
	Stops SMDR processing.

	[image: image38.bmp]
	Edit XE "Edit" , Cut XE "Cut" .
	Deletes the current selection and copies it to the clipboard.

	[image: image39.bmp]
	Edit, Copy XE "Copy" .
	Copies the current selection to the clipboard.

	[image: image40.bmp]
	Edit, Paste XE "Paste" .
	Pastes the contents of the clipboard to the current location.

	[image: image41.bmp]
	
	Sort the table on the current field.

	[image: image42.bmp]
	
	Sort the table backwards on the current field.

	[image: image43.bmp]
	Edit, Find XE "Find" .
	Find a record.

	[image: image44.bmp]
	
	Add a new record.

	[image: image45.bmp]
	
	Delete the current record.

	[image: image46.bmp]
	
	Go to the first page of a report.

	[image: image47.bmp]
	
	Go to the previous page of a report.

	[image: image48.bmp]
	
	Go to the next page of a report.

	[image: image49.bmp]
	
	Go to the last page of a report.

	[image: image50.bmp]
	
	Stop generating the report

	[image: image51.bmp]
	
	Zoom the report. (Change report magnification.)

	[image: image52.bmp]
	
	Print the report.


The Status Bar XE "Status Bar" 
The Status bar at the bottom of the screen carries information about the status of your system.

If the Status bar is not visible, you can make it visible by selecting Status bar from the View menu.

	Tip.  If you are not sure what a Status bar panel indicates, then move the cursor over the panel without clicking. After a few seconds, a ToolTip XE "ToolTip"  label describing the purpose of the panel will appear.


Depending upon how TeleTiger is configured and which Window is active, not all of the following Status bar panels may be visible or enabled. For instance, if Security is not enabled, then the Current Logged-on User panel will not be visible.

License XE "License" 
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The license panel of the Status bar shows what sort of license you have purchased. If a plus sign is shown, then the product is fully licensed. 

[image: image89.png]ym{




If a number is shown, then the software is leased, rented or on loan and the temporary license will expire after the number of days shown.

License configuration can be changed or extended over the telephone by your TeleTiger dealer.

Language XE "Language" 
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The language panel of the Status bar shows the current screen language.

You can change language by double clicking or right-clicking on this panel. (See also How to change language on page 3.)

Data processing XE "Data processing" 
The Data processing panel of the Status bar shows the current Data processing state. 

If data is actually being processed, then the panel shows a blue progress bar showing how much of the current buffer file has been processed so far. 

If data is not being processed, then the panel shows either Pause or Stop, depending upon the processing state selected by the user. 
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Current user XE "Current user" 
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The Current user panel of the Status bar shows the name of the user who is currently logged-on. 

If security is not enabled, then this panel will not be visible. (See page 3 for more information about security.)

Current user security level XE "Current user security level" 
[image: image93.png]


The Current user security level panel of the Status bar shows the security level of the user who is currently logged-on. 

If security is not enabled, then this panel will not be visible. (See page 3 for more information about security.)

Time and Date XE "Time and Date" 
[image: image94.bmp]The Time XE "Time"  and Date XE "Date"  panels of the Status bar show the current time and date of the PC’s operating system XE "operating system" . Depending upon how the system is configured, then the Gregorian XE "Gregorian"  date, the Hijri XE "Hijri"  date or both will be shown. 

(See page 3 for more information about changing calendar systems XE "calendar systems" .)

Arabic XE "Arabic" 
TeleTiger is fully bilingual XE "bilingual"  in Arabic and English. TeleTiger is also available in other single languages and groups of languages.

You can change from one screen language to another with a single mouse-click at almost any time.

 How to change language XE "How to change language" 
There are several ways of changing screen language. You can use whichever of the following methods you prefer.
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Click on the Toolbar button for the language you want 

Or

 Select Language from the View menu. 

Or

 Click on the name of the language on the menu bar. 
Or

 Double-click on the Current Language panel of the Status bar. 
Or

 Right-click on the Current Language panel of the Status bar.

	Note. The keyboard language XE "keyboard language"  may not necessarily be the same as the screen display language XE "screen display language" . To determine the current keyboard language, look at the Windows Task Bar XE "Task Bar" 

 XE "Windows Task Bar" . This should display EN for English or AR for Arabic.


 How to change the keyboard language

There are two alternative ways of changing the keyboard language.

 Click on EN or AR in the Windows Task Bar, then select the language you want.

Or

 Type Ctrl-Shift and Alt-Shift using the left-hand Shift key for English, or the right-hand Shift key for Arabic.

	Tip. Be particularly careful to note which keyboard language you are using when entering passwords. Passwords are acceptable in either English or Arabic. If TeleTiger is configured to hide password entry, then you will not be able to see what you are typing. Make sure you type your password XE "password"  in the appropriate language


Logging-on and off

If Security is enabled, then you must log-on XE "log-on"  before using TeleTiger.

[image: image97.png]


When TeleTiger is first installed, the default User name is Administrator XE "Administrator"  and the default password XE "default password"  is tiger.
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[image: image99.bmp]How to Log-on XE "How to Log-on" 
17. Select Log-on from the menu bar, or click

18. The Log-on screen appears. 

19. Make sure that the User name is correct. Change it if required.

20. Type in your password and press Enter (or click OK).
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The Status bar shows the current logged-on user and security level. 

	Tip If you have trouble logging-on, make sure that you are typing your password in the correct keyboard language. Also remember that depending upon how TeleTiger is configured, passwords can be case sensitive XE "case-sensitive" .


[image: image101.bmp]If you try to access an option without logging-on, then TeleTiger will ask you if you want to log-on.

 [image: image102.bmp][image: image103.bmp]How to Log-off XE "How to Log-off" 
Select Log-off from the menu bar, or click 

For more information about Security, see page 3.

Calendar XE "Calendar" 
TeleTiger has full simultaneous support for both the Gregorian XE "Gregorian"  (Western) and Hijri XE "Hijri"  (Islamic) calendars. TeleTiger is also available with support for other calendar systems.

You can change from one calendar to another at almost any time.

 How to change calendars XE "How to change calendars" 
There are several ways of changing calendars:

 Select Calendar from the View menu. 
Or

 Double-click on any Date display panel in the Status bar. 
Or

 Right-click on the Date display panel of the Status bar.

	Tip You can display both Gregorian and Hijri dates at the same time by selecting Both. If both are displayed, then changing calendar systems determines which takes priority for data-entry.


Displaying the data XE "Displaying the data" 
There are two main windows that are of primary interest in displaying telephone call data. These are:

 The Raw Data XE "Raw Data"  Window

 The Calls Table XE "Calls Table" 
The Raw Data Window XE "The Raw Data Window" 
This window shows the raw data exactly as it is received from the PABX. If you connected a simple serial printer to your PABX instead of a PC running TeleTiger, this is what you would see.

 How to make the Raw Data window appear XE "How to make the Raw Data window appear" 
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Select Raw Data XE "Raw Data"  from the View XE "View"  menu, or click on 

[image: image105.bmp]You can move backwards and forwards through the data using the vertical scroll bar and you can scroll from left to right using the horizontal scroll bar.

If call processing is turned on, then the Raw Data window will scroll automatically back to the bottom each time a new call is received. 

The main difference you will notice between the data shown in the Raw Data window and the same data as you would see it on a simple serial printer is that the Raw Data window color codes each line of data as it is received. These color codes each have a specific meaning.

Color codes XE "Color codes" 
 Black XE "Black"  This is a valid outgoing call and has been costed and entered into the database.

 Blue XE "Blue"  This is a valid incoming call and has been costed and entered into the database. (You can assign a cost to incoming calls if you wish.)

 Green XE "Green"  This line is recognized, but does not represent a connected call. Examples are data for calls that did not connect, page headings, calls you have chosen not to process (e.g. local calls) or any other expected and recognized SMDR sent by the exchange that does not represent a connected and logged call.

 Red XE "Red"  This line is not expected and is not recognized. The usual cause is misconfiguration or a technical problem with the PABX, cable or PC.

The Calls Table

This window shows the processed calls as they appear in the database. Unconnected calls and non-call data do not appear

 [image: image106.png]


How to make the Calls Table appear XE "How to make the Calls Table appear" 
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Select Calls from the Tables menu, or click on

[image: image108.bmp]You can move backwards and forwards through the data using the vertical scroll bar and you can scroll from left to right using the horizontal scroll bar.

If the Dynamic checkbox at the bottom of the table is checked, then the table is dynamic and new calls will be added to the bottom of the table as they appear.
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If you have moved up through the table using the vertical scroll bar, then the table will automatically scroll to the bottom each time this happens. If you do not want this to happen, then uncheck the Dynamic XE "Dynamic"  check box. The table will then be static and will not be updated with new calls until you again check the Dynamic check box, or you close and reopen the Calls Table. 

You can reconfigure the Calls Table to change the width of the columns or to hide or display certain columns. (See Configuring Columns on page 3.)

Controlling the screen layout XE "screen layout" 

 XE "Controlling the screen layout" 
If you have displayed more than one window (for instance the Raw Data window and the Calls Table window) then the display may not be arranged to your liking. One window may be covering the other. 

You can rearrange the windows in various different ways to suit your style of working.

Practice XE "Practise" 
If you want to practice, you should now open several windows.

 How to open windows for practice. XE "How to open windows for practice." 
21. Select Look-up Tables from the Tables XE "Tables"  menu.

22. Select one of the tables from the displayed list.

23. Repeat the above until you have three or four tables loaded.

	Tip When you have finished practicing, close each window by clicking on  [image: image53.bmp]  


Window State XE "Window State" 
Generally, you can set any given window to one of three states, or close it completely

 How to change the state of a window: XE "How to change the state of a window\:" 
24. Click on the icon in the top-left-hand corner of the window. 

25. Select the required menu option, as shown in the table below.

Or

 Click on a button at the top-right-hand corner of the window, as shown in the table below.

	Button
	Menu option
	Action

	[image: image54.bmp]
	Maximize
	Fills all of the available space

	[image: image55.bmp]
	Minimize
	Shrinks to minimum size

	[image: image56.bmp]
	Restore
	Restored to normal size

	[image: image57.bmp]
	Close
	Closes the window


Window Size XE "Window Size" 
You can move and resize a normally sized window with the mouse.

 How to move a window with the mouse XE "How to move a window with the mouse" 
26. Put the mouse cursor over the title bar at the top of the window.

27. Press the left mouse button and hold it down

28. Move the mouse to drag the window to a new position

29. Drop the window in the new position by releasing the mouse button

This action is known as drag-and-drop. 

 How to resize a window with the mouse XE "How to resize a window with the mouse" 
30. Put the mouse cursor over one of the borders of the window. The mouse cursor will change to a double-ended arrow when you are in the right place.

31.  Press the left mouse button and hold it down

32. Move the mouse to resize the window as required.

33. Release the mouse button

Selecting the window you want XE "Selecting the window you want" 
If you maximize a TeleTiger NT window, then all similar windows will also be maximized, but you will only be able to see the one that is on top.

If windows are of normal size, you may be able to see all or part of the window you want.

If one or more windows are minimized, you may or may not be able to see the window you want.

  How to make the window you want appear. XE "How to make the window you want appear." 
 [image: image110.bmp]If you can see any part of the window you want, click on it. If it is minimized, click on

Or

1. Click on the icon at the top-left-hand corner of a window.

2. Select Next.

Or

 Hold down the Ctrl key and press the F6 key.

Or

34. Click on the Windows menu XE "Windows menu" .

35. Select the window you want from the list that appears

	Tip. If the same window name appears more than once, then you have loaded more than one copy of the same table. This is quite permissible. For instance, you may want to load one copy of the extensions table, sorted by extensions and another sorted by name. 


Arranging windows XE "Arranging windows" 
If you have more than one window loaded, it may be convenient to arrange them neatly on the screen. They can either be arranged so that only the title bar of each is visible, or they can be arranged so that no window is covering another.

 How to arrange windows on the screen XE "How to arrange windows on the screen" 
36. Click on the Windows menu

37. Select the required menu option as shown in the table below.

	Menu option
	Action

	Tile Horizontally XE "Tile Horizontally" 
	Windows are arranged horizontally to use all of the space available, but without overlapping each other. Best for short but wide tables.

	Tile Vertically XE "Tile Vertically" 
	Windows are arranged vertically to use all of the space available, but without overlapping each other. Best for long but narrow tables.

	Cascade XE "Cascade" 
	Windows are arranged in an overlapping cascade, but with every window’s title bar visible.

	Arrange icons XE "Arrange icons" 
	The icons for any minimized windows are grouped neatly at the bottom left of the main window.


Using tables XE "tables" 
Much of the information contained in the main program database is displayed in the form of tables.

[image: image111.png]



Columns XE "Columns" 
Each vertical section containing data is called a Column.

Rows XE "Rows" 
Each horizontal section containing data is called a Row or a Record. (Strictly speaking, the Row is the physical section in the table and the Record is the data from the underlying database that it contains.)

Cells XE "Cells" 
Each individual box containing data is called a Cell or a Field XE "Field" . (Strictly speaking, a Cell is the physical box in the table and the Field is the data from the underlying database that it contains.)

Opening tables XE "Opening tables" 
The tables used in TeleTiger NT include the Calls table XE "Calls table"  which stores information about telephone calls made, and the Look-up tables XE "Look-up tables"  which are used to look-up data for various purposes.

 How to open the Calls table XE "How to open the Calls table" 
 Select Calls from the Tables menu 

Or
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Click on

 How to open a Look-up table XE "How to open a Look-up table" 
1. Select Look-up tables from the Tables XE "Tables"  menu

2. A drop-down menu appears

3. Select the table you want from the drop-down menu.
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A Table selection window appears

3. Click on the table you want

4. Click on OK.

	Tips. To open a table quickly, double-click on its name instead of selecting it and clicking on OK.

If you can not see the table you want, use the scroll bar to scroll the window. 


Moving around

 How to move around in the table XE "How to move around in the table" 
 If you can see the field you want, click on it.

Or

 Use the Arrow keys on your keyboard to move around.

Or

 [image: image115.bmp]Use the Scroll Bars at the bottom and side of the table to move around.

Or

 [image: image116.bmp]Use the buttons on the Data Control at the bottom of the table to move around. 

The data control buttons work in accordance with the following table:

	Button
	Action

	[image: image58.bmp]
	Go to the first record.

	[image: image59.bmp]
	Go to the previous record.

	[image: image60.bmp]
	Go to the next record.

	[image: image61.bmp]
	Go to the last record.


Configuring columns

Column widths are not fixed. You can adjust them as you require. You can even hide a column completely by adjusting its width to zero. 

 How to adjust the width of a column

1. Place the cursor over the dividing line between two columns.
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When you are in the correct position, the cursor looks like this: 

3. Press the left mouse button and hold it down.

4. Move the mouse until the column is the required width.
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Release the mouse.

 How to hide a column XE "hide a column" 

 XE "How to hide a column" 
1. Place the cursor over the dividing line between two columns.
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When you are in the correct position, the cursor looks like this: 

3. Press the left mouse button and hold it down.

4. Move the mouse to the left until the column disappears.

5. Release the mouse.

 How to make a hidden column XE "hidden column"  appear XE "How to make a hidden column appear" 
1. Place the cursor over the dividing line between two columns.
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If there is a hidden column, the cursor looks like this: 

3. Press the left mouse button and hold it down.

4. Move the mouse to the right until the column appears.

5.  Release the mouse.

	Tip  When you first open a table, the position of any columns that have been hidden are shown by extra vertical dividing lines. 
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How to save column width changes XE "column width changes" 

 XE "How to save column width changes" 
1. Close the table, or switch languages.

2. You will be asked if you want to save the changes to the layout of the table.

3. Select Yes to save the changes or No to discard them.

Dynamic Tables XE "Dynamic Tables" 
Some tables have the capability to be Dynamic. A table that is dynamic is one that updates itself automatically in real time. An example is the Calls table. A new telephone call received from the PABX will be dynamically added to the end of the table in real time. Since this might be distracting if you are working on the table, you can chose whether the table is dynamic or not. 

 How to control whether or not a table is dynamic XE "How to control whether or not a table is dynamic" 
 Check the Dynamic box at the bottom of the table if you want the table to update dynamically.

Or
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Uncheck the Dynamic XE "Dynamic"  box at the bottom of the table if you do not want the table to update dynamically.

Changing the sort-order of a Table XE "sort-order of a Table" 

 XE "Changing the sort-order of a Table" 
You can sort any table on any field, either in alphabetical order or reverse alphabetical order.

 How to sort a table XE "How to sort a table" 
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Click the column or field on which you want to sort.

2. To sort in alphabetical order click on 
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Or

To sort in reverse alphabetical order click on

Finding data XE "Finding data" 
If you are working with a large table, it may not be easy to find the data you want. You can search for data using the Find command.
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How to find the data you want XE "How to find the data you want" 
1. Select Find XE "Find"  from the Edit menu or click on

2. The Search form appears

3. Enter what you are looking for in the Find What box.

4. If required, change the search XE "search"  parameters (see table below).
5. Click on Find First or Find Next.
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	Search Parameter
	Usage

	Find what XE "Find what" 
	Enter the data you want to find.

	Search XE "Search" 
	Select All to search all of the table. Select Up to search upwards from the present point in the table to the top. Select Down to search downwards from the present point in the table to the end.

	Match XE "Match" 
	Select Match whole field if you want to find only whole fields that match the search text . Select Any part of field if you want to find all fields that contain the search text in any position. Select Start of field if you want to find only fields that start with the search text.

	Match Case XE "Match Case" 
	Check this box if you want the search to be case sensitive, e.g. searching on ‘Manager’ will not find ‘manager’.

	Search Fields as Formatted XE "Search Fields as Formatted" 
	Check this box if you want to find only fields that match the search text exactly, even after formatting, e.g. searching on ‘0.5’ will not find ‘0.500’.

	Search current field XE "Search current field" 
	Check this box if you only want to search in the currently selected field.

	Find First XE "Find First" 
	Click here to find the first matching occurrence of the search text. If Search is set to All or Down, this will be the first matching field from the top of the table. If Search is set to Up, then this will be the first matching field from the bottom of the table.

	Find Next XE "Find Next" 
	Click here to find the next matching occurrence of the search text. If Search is set to All or Down, this will be the next matching field moving down or to the right. If Search is set to Up, then this will be the next matching moving up or to the left.

	Cancel XE "Cancel" 
	Click here to cancel the search.


Changing data XE "Changing data" 
The data editing characteristics of the software are designed to match commonly accepted industry standards, such as those implemented by the © Microsoft Office range of products. If you are familiar with © Microsoft Access or © Microsoft Excel, then you should find the interface very familiar.

 How to change data XE "How to change data" 
1. Click the field you wish to edit

2. To replace the current data completely, type the new data.

Or

To edit the existing data, press the F2 key.

	Tip. If you are unable to change data, it is likely you do not have a high enough security level to change data in that table. See Security on page 3 for more information. 


Adding data XE "Adding data" 
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At the bottom of each table is an empty row for the addition of new data.

 How to add data XE "How to add data" 
1. Navigate to the bottom of the table
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Or

Press

2. Enter the new data

	Tip. If you are unable to enter new data, it is likely you do not have a high enough security level to add data to that table. See Security on page 3 for more information. 


Data verification XE "Data verification" 
Not all data is acceptable in all fields. For instance a field that holds a date will not accept a value of “ABCDEFG”. 

If the data is found to be unacceptable, an error message will appear and the focus will be returned to the data row that caused the error.

 How to deal with unacceptable data XE "unacceptable data" 

 XE "What to do if you enter unacceptable data" 
1. Click on the field that contains the unacceptable data

2. Re-enter the data in an acceptable form

Or

Press the Esc key to restore the previous data values.

Deleting records XE "Deleting records" 
You can delete one or more records at the same time. You must first select the record or records you wish to delete.

 How to select XE "select"  a record XE "To select a record" 
1. Click on the gray box at the left of the row you wish to delete. This gray box is known as a Record Selector.

2. [image: image128.png]Tk,
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The selected row turns blue.

 How to select more than one record XE "To select more than one record" 
 Hold down the Ctrl key, whilst clicking the record selector(s) of the records you wish to select or deselect.

Or

 Click on the selector of the first record you want to delete , then hold down the Shift key whilst clicking on the last record you want to delete. All of the records in between will be selected.
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How to delete selected records

1. [image: image130.png]User
2 —
Passwo
Add [

Coriim password:

I I




[image: image131.png]Genersl Usets | Secay | Pl Locaons| Fieses | UDE.|

Users

s
& [T
Add ¥ Can change password

B o ——

Secuiy level

=0 If

0K Cancel e




Click on

2. A warning message appears

3. Click on Yes to delete the records

Or

Click on No or Cancel to stop the delete

	Tip. If you are unable to delete data, it is likely you do not have a high enough security level to remove data from that table. See Security on page 3 for more information. 


Chapter 4 — Configuration
Configuration XE "Configuration" 
Tables XE "Tables" 
Tables are used extensively in TeleTiger NT. If you are unfamiliar with the use of tables, you are strongly advised to read Using Tables (page 3). 

Call Types table XE "Call Types table" 
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The Call Types table has an entry for each type of call. TeleTiger NT comes with certain pre-defined call types, but you can modify these if you wish. You can even create your own call types and use these for filtering or sorting tables and reports.

Type Code XE "Type Code" 
The Type code is an abbreviation for the type of call. The type code for each call is found by matching the dialed number against the area code in the Rates table.  This type code is then used to look up certain information in the Call types table.

Call records in tables and reports can be filtered and/or sorted on Call type (including user-defined Call-types). 

TeleTiger NT has certain call type codes predefined, but you can change these or create your own call types if you wish.

If you add or change call type codes, you should do this in the Rates table. You must also enter the new type code in the Call Types table (or let TeleTiger do this for you automatically, the first time it processes a call of that type).

Type XE "Type" 
The Type field contains the full name of the call type for the Type code concerned.  For instance, Type code “INT” might match to Type “International call”.

There are two Type fields, one for the call type in Arabic script and the other in English script.

	Tip. Bear in mind that depending upon how you have configured TeleTiger, the Arabic Type field may be hidden, i.e. set to zero width, when screen language is set to English.  (See Configuring columns on page 3 for more information on revealing hidden columns.)


Minimum seconds XE "Minimum seconds" 
If your PABX is incapable of telling you whether or not a call has connected, then TeleTiger can ‘guess’ connection status on the basis of duration. 

If you enter a value of (for instance) 30 seconds for local calls, then all local calls of less than 30 seconds will be classified as unconnected calls and all calls of 30 seconds or more will be considered to have connected.

Before considering the duration of the call, TeleTiger will first check the Minimum dialed digits. (Any call that does not have enough dialed digits can not have connected, however long the duration.)

NOTE: These factors will only be used to determine connection status on unsupervised trunks. If you are unlucky enough to have any unsupervised trunks, you should define which these are in the Trunks table.  

	Caution  If your PABX does not properly report call connection status, then TeleTiger NT can ‘guess’ the status based upon the duration and the number of digits dialed; but remember that this is only a guess and will never be 100% accurate. 

This inaccuracy represents a defect in the PABX and/or trunk line, not in TeleTiger NT. 

The only solution to this problem is to have a PABX that reports connection status properly. Please see Connection status on page 3 for more information.


Minimum dialed digits XE "Minimum dialed digits" 
If your PABX is incapable of telling you whether or not a call has connected, then TeleTiger can ‘guess’ connection status on the basis of the number of digits dialed. 

If you enter a value of (for instance) 7 digits for local calls, then all local calls with less than seven dialed digits will be classified as unconnected calls.

NOTE: These factors will only be used to determine connection status on unsupervised trunks. If you are unlucky enough to have any unsupervised trunks, you should define which these are in the Trunks table.  

	Caution  If your PABX does not properly report call connection status, then TeleTiger NT can ‘guess’ the status based upon the duration and the number of digits dialed; but remember that this is only a guess and will never be 100% accurate. 

This inaccuracy represents a defect in the PABX and/or trunk line, not in TeleTiger NT. 

The only solution to this problem is to have a PABX that reports connection status properly. Please see Connection status XE "Connection status"  on page 3 for more information.


Logging XE "Logging" 
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All call types that will not be logged, have a red cross in this field.

If there are any call types that you do not wish to log, e.g. if you do not want to log local or incoming calls, then click on this field until it changes to a red cross.

	Tip  Even though you may not be logging calls for a particular call type, remember that all raw SMDR data is retained. If you later decide that you would like to have calls of this type in the database, you can always reprocess the raw SMDR later to recover the calls.


Charge points XE "Charge points"  table XE "Charge points table" 
A Charge Point is the point to which an individual telephone call is charged. 

In a simply configured TeleTiger system, the Charge Point would be the same as the physical extension number, i.e. all telephone calls made on extension 123 would be charged to extension 123.
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For more information about Charge Points, see page 3.

Charge point XE "Charge point" 
Charge points are determined by looking for matching factors in the Cost Allocation table and Physical extensions table. If nothing specific is found, then the Charge point will be the same as the Extension number sent by the PABX.

Whatever Charge point is determined by TeleTiger, will be automatically added to the Charge points table.

Name XE "Name" 
The Name field can contain any text that you wish, normally the name of the person who is responsible for that Charge point/Extension, or other information such as a Hotel room-number.

There are two Name fields, one for the name in Arabic script and the other in English script.

	Tip. Bear in mind that depending upon how you have configured TeleTiger, the Arabic name field may be hidden, i.e. set to zero width, when screen language is set to English.  (See Configuring columns on page 3 for more information on revealing hidden columns.)


UDF XE "UDF"   (Section XE "Section" )

The UDF (or User Defined Field XE "User Defined Field" ) can be used for anything you wish — perhaps a Job title, Section name or an employee ID number.

You can change the name of the UDF from the Options XE "Options"  window (page 3). The default name for the UDF field is Section.

There are two UDF’s, one for the UDF data in Arabic script and the other in English script.

	Tip. Bear in mind that depending upon how you have configured TeleTiger, the Arabic UDF may be hidden, i.e. set to zero width, when screen language is set to English.  (See Configuring columns on page 3 for more information on revealing hidden columns.)


Department XE "Department" 
The Department field can contain any text that you wish, normally the department or group name.

 There are two Department fields, one for the department in Arabic script and the other in English script.

	Tip. Bear in mind that depending upon how you have configured TeleTiger, the Arabic Department field may be hidden, i.e. set to zero width, when screen language is set to English.  (See Configuring columns on page 3 for more information on revealing hidden columns.)


Mark-up code XE "Mark-up code" 
You may wish to mark-up the cost of calls. For instance, if you run a hotel you may want to mark up calls by 10%.

Different mark-up methods and strategies can be defined in the Mark-ups table. Each mark-up strategy has a Mark-up code associated with it in the Mark-ups table.

If you want to apply this mark-up strategy to a particular Charge point (or group of Charge points) then place the matching Mark-up code (from the Mark-up table) in this field.

	Tip. TeleTiger keeps a completely separate record of the basic charge (PTT cost) charge and the Marked-up charge (User cost) for the call. Thus reports showing the PTT cost, the User cost or both costs may be prepared. It is even possible to show the profitability of the system by deducting one cost from the other. (See Cost on page 3 for more information.)


Fixed charge code XE "Fixed charge code" 
You may wish to apply a fixed charge (such as a telephone-set rental charge) to certain charge points on a regular basis. For instance you may want to charge tenants a certain amount each month, regardless of the number or value of telephone calls made.

Different fixed-charge methods and strategies can be defined in the Fixed charges table. Each fixed-charge strategy has a Fixed charge code associated with it in the Fixed charges table.

If you want to apply this fixed-charge strategy to a particular Charge point (or group of Charge points) then place the matching Fixed charge code (from the Fixed charge table) in this field.

Cost Allocation XE "Cost Allocation" 
The Cost allocation table XE "Cost allocation table"  is used to configure where costs should be allocated, i.e. which Charge point should bear the cost of any individual call. 

In a simply configured TeleTiger NT system, the cost of a call is allocated to the extension that dialed it (the extension and the Charge point are identical).

Some PABX’s permit the use of PIN’s, or Personal Identification Numbers. A PIN is a special secret number that a user dials before making a call. Depending upon the model and programming of the PABX, the PIN may be an optional means of indicating where a call should be charged, or it may be a compulsory number that must be dialed to gain certain access to a trunk line. You may wish to charge all the calls made using a certain PIN number to the same Charge point, regardless of the actual physical extension used.
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You can also allocate the Charge point on the basis of the number dialed or the extension used. Please see Charge points on page 3 for more information about cost allocation.

Charge point XE "Charge point" 
Enter the Charge point you wish to bear the cost of calls that match the specifications you will enter on this line. Every entry in the table should have a charge point and one or more entries in the other columns.

You can enter the same Charge point in the Charge points table (together with the Name and other information) if you wish, although TeleTiger will automatically insert the Charge point in the Charge points table the first time a call is made that resolves to this Charge point.

PIN code XE "PIN code" 
If you enter a PIN code here (and leave Extension and Number blank) then any calls made using this PIN code will be charged to the Charge Point in the same row.

Number XE "Number" 
If you enter a Number here (and leave Extension and PIN code blank) then any calls made to this number will be charged to the Charge Point in the same row. 

	Tip. You do not need to enter a complete number here. For example, if you enter only ‘0044’ then all calls to the UK will be charged to the the Charge Point in the same row.

You can include the extended numbers from a call attendant system in this field. For instance, if you call a company with the number 2212060 and then dial 120 for extension 120, you can set this field to 2212060120 then all calls to this number and extension will be charged to the Charge Point in the same row


Extension XE "Extension" 
If you enter a Physical Extension number here (and leave PIN code and Number blank) then any calls made using this Physical Extension will be charged to the Charge Point in the same row.

	Tip. You can combine fields in this table. For instance if you enter Charge Point 123, extension 222, PIN code 999999 and number 026651904 (in the same row), then Charge Point 123 will be charged for all calls that are made to number 026651904 from extension 222 using PIN code 999999, but not for the same PIN code and number when dialed on other extensions etc.

Using this system you could, for instance,  arrange for an employee’s calls to his home number to be charged to his personal calls Charge point when called from his own extension (he is calling his family at home), but to be charged to his boss’s business calls Charge point when called from his boss’s extension (the boss is trying to reach the employee himself on a business matter.)


Events log XE "Events log" 
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The Events log contains a record of significant security events, such as when the program stopped or started. Where a network is involved and there are multiple PC’s that process and access the data, then records for each are stored in the log.

User XE "User" 
This is the name of the user who was logged-on when the event occurred. If security is not enabled, or if the event occurred when no user was logged-on, then this field will be blank.

When XE "When" 
This is the time and date that the event occurred.

Security level XE "Security level" 
This is the Security Level of the user who was logged-on when the event occurred. If security is not enabled, or if the event occurred when no user was logged-on, then this value will be 0

Language. XE "Language." 
The is the screen language of the TeleTiger system at the time the event occurred.

Computer XE "Computer" 
This is the name of the computer upon which the event occurred.

Event XE "Event" 
This is the event that occurred.

Extension conversion XE "Extension conversion" 
It is possible that the extension number sent by the PABX is different from the extension number you wish to use. 

For example, some brands of PABX can be programmed to display the name of the person who owns the extension in the SMDR record instead of the actual extension number, which is not shown in the SMDR record at all. 

Another example is where a very old mechanical exchange is fitted with an electronic scanner to generate SMDR data artificially. In this case, the number the scanner generates to identify the circuit may not be the same as the actual extension number. 
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In either caset, the Extension conversion table will convert an extension number from that specified in the SMDR to any other value you wish to define, before forwarding the record for processing.

Extension in XE "Extension in" 
This is the extension number reported in the SMDR.

Extension used XE "Extension used" 
The Extension number reported in the SMDR is converted to this value, before processing.

	Tip. TeleTiger does not alter the actual original SMDR data. This is preserved in the Raw Data table in exactly the form it was received. The extension number is changed only in the processed data, e.g. the Calls table.


Fixed charges XE "Fixed charges" 
You may wish to apply a fixed charge (such as a telephone-set rental charge) to certain charge points on a regular basis. For instance you may want to charge tenants a certain amount each month, regardless of the number or value of telephone calls made.

Different fixed-charge methods and strategies can be defined in the Fixed charges table. Each fixed-charge strategy has a Fixed charge code associated with it in the Fixed charges table.

If you want to apply this fixed-charge strategy to a particular Charge point (or group of Charge points) then place the matching Fixed charge code (from the Fixed charge table) in this field in the Charge Points table.
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Fixed charge code XE "Fixed charge code" 
This is a code identifying a certain fixed charge. This value should be placed in the fixed-charge code field of the Charge Points table for any extension that should have this fixed charge strategy applied to it.

Fixed monthly charge XE "Fixed monthly charge" 
This is the fixed amount that should be charged each month to any Charge Point that has the matching Fixed Charge Code associated with it in the Charge Points table.

	Tip. Extra columns can be added to allow for fixed charges for periods other than months, for instance quarterly or annual charges. Please ask your TeleTiger dealer for details.


Identities XE "Identities" 
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The Identities table is used to define the Identity of any well-known or often-called numbers so that they can be easily identified in reports.

Number XE "Number" 
The dialed number

	Tip. You can include the extended numbers from a call attendant system in the identity. For instance, if you call a company with the number 2212060 and then dial 120 for extension 120, you can set the identity of number 2212060120 to the name of the person at extension 120. 


Identity XE "Identity" 
The identity of the dialed number

There are two identity fields, one for the Identity in Arabic script and the other in English script.

	Tip. Bear in mind that depending upon how you have configured TeleTiger, the Arabic Identity may be hidden, i.e. set to zero width, when screen language is set to English.  (See Configuring columns on page 3 for more information on revealing hidden columns.)


Mark-ups XE "Mark-ups" 
You may wish to mark-up the cost of calls. For instance, if you run a hotel you may want to mark up calls by 10%.

[image: image141.png]Gnerl] s Sty | Pl Locaons| i ses [
e

[secton

0K Cancel Aoty




Different mark-up methods and strategies can be defined in the Mark-ups table. Each mark-up strategy has a Mark-up code associated with it in the Mark-ups table.

Mark up code XE "Mark up code" 
This is a code defining this mark up strategy.

If you want to apply this mark-up strategy to a particular Charge point (or group of Charge points) then place the matching Mark-up code (from the Mark-up table) in this field in the Charge Points table.

Give PTT discount XE "Give PTT discount" 
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Mark ups that include the normal PTT discount have a green tick
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Mark ups that do not include the normal PTT discount have a red cross

(Click on the field to change from one to the other.)

Mark up % XE "Mark up %" 
The percentage by which calls are to be marked up.

	Tip. TeleTiger keeps a completely separate record of the basic charge (PTT cost) charge and the Marked-up charge (User cost) for the call. Thus reports showing the PTT cost, the User cost or both costs may be prepared. It is even possible to show the profitability of the system by deducting one cost from the other. (See Cost on page 3 for more information.)


Pending transfers XE "Pending transfers" 
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The pending transfers table contains information about transferred calls in progress. i.e. where the first part of the transfer has completed, but the second part of the call is still in progress. This table is provided for diagnostic purposes and you should not need to modify any of the data directly.

	Note TeleTiger keeps a historic record of the last call sequence for each trunk line in this table. On many exchanges it is not possible to tell if a call is a transferred call from the first part of the transfer sequence, so data must be retained until another call comes along on the same trunk line and flushes the record. Thus this table normally shows the last call (connected or attempted) on each trunk line. The presence of a record for a specific trunk line does not necessarily imply that there is a transfer sequence in progress at that moment on that trunk.


Physical extensions XE "Physical extensions" 
The Physical Extensions table has a record for each physical extension used on the system. A physical extension is an actual telephone, wired to the PABX. It is different from a Charge Point. A Charge point can be a physical extension, but it can also be any arbitrary group of numbers or letters that are a convenient tag for charging groups of calls.

TeleTiger is licensed by the number of physical extensions and will not process SMDR from more than the number of physical extensions licensed. (Charge points are unlimited, and you can define as many as you wish).
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(Physical extensions that are placed in the Physical Extensions to Ignore table are not counted towards the license.)

Extension XE "Extension" 
The number of the physical extension. TeleTiger will automatically fill this table with the extension numbers received from the PABX, although you can also manually enter the numbers if you wish.

Attendant XE "Attendant" 
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Extensions that belong to secretaries or telephone attendants are marked 
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Those that do not are marked 

(Click on the field to change from one to the other.)

When calls are transferred, if no special factors apply (such as PIN codes), then the call is normally charged to the extension that dialed it. However, if the dialing extension is marked as an Attendant extension, then the call is charged to the party to whom it is transferred.

	Tip Any extensions who normally dial calls on behalf of someone else and then transfer them (such as telephone console attendants and personal secretaries) should be marked as Attendant extensions, unless you want them to directly bear the cost of all calls they have dialed.


Physical extensions to ignore XE "Physical extensions to ignore" 
TeleTiger NT can be configured to ignore certain trunk lines or extensions. 

A company president may wish to monitor and control telephone use within his company, but might not want information about the use of his personal telephone extension or dedicated trunk line to be recorded.

[image: image148.png]Stattine =l
& =




The first thing TeleTiger does with an SMDR record is to look up the trunk line in the Trunks to Ignore look-up table and the physical extension in the Physical extensions to ignore look-up table. If the call is found in either table, then no further action is taken and the call is not processed — however the raw SMDR data is retained.

Extension XE "Extension" 
Place the number of any extension you wish to be ignored in this table. 

Note that if a transfer call is made from an extension in this table to another extension, then the entire call will be ignored 

(Physical extension numbers placed in this table do not count towards your licensed total of number of extensions.)

Rates table XE "Rates table" 
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When a telephone call is received from the PABX, the dialed number is matched against the Rates table to find out other information about the call, such as the destination dialed and the rate per minute.

Area code XE "Area code" 
The dialed telephone number is matched against the nearest Area code to find the information required. 

The longest matching code is used, so the number “015551234” would be matched to area code “0155” rather than “01” , if both area codes were present in the table.

Rate XE "Rate" 
This is the rate per minute for the area code concerned. This rate is the PTT rate for the call. This value should not be modified to mark-up calls (for instance, for hotel rooms). Call mark-ups should be made via the Mark-ups table.

Type code XE "Type code" 
The Type code is an abbreviation for the type of call. It is used to look up data in the Call types table, where the full name of the call type and other information is stored.

Call records in tables and reports can be filtered and/or sorted on Call type (including user-defined Call-types). 

TeleTiger NT has certain call type codes predefined, but you can change these or create your own call types if you wish.

If you add or change call type codes, you should do this in the Rates table. You must also enter the new type code in the Call Types table (or let TeleTiger do this for you automatically, the first time it processes a call of that type).

Charge band XE "Charge band" 
PTT authorities may offer off-peak discounts at certain times (or on certain Gregorian or Hijri dates). Each discount grouping is referred to as a Discount Charge band. The Charge band field defines which discount charge band should be used for a given area code.

Location XE "Location" 
The Location field contains the name of the location for the area code concerned. 

There are two location fields, one for the location in Arabic script and the other in English script.

	Tip. Bear in mind that depending upon how you have configured TeleTiger, the Arabic location field may be hidden, i.e. set to zero width, when screen language is set to English.  (See Configuring columns on page 3 for more information on revealing hidden columns.)


LCA XE "LCA" 
The LCA number is a number used by PTT XE "PTT"  authorities XE "PTT authorities"  to identify certain PTT exchanges or groups of exchanges. This is useful, as certain PTT exchanges in different areas may have identical or similar names.

Trunk lines XE "Trunk lines" 
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The trunk lines table contains the numbers of all trunk lines on the system.

Trunk XE "Trunk" 
This is the number of the trunk, as reported in the SMDR record. TeleTiger will automatically fill this table with the trunk numbers received from the PABX, although you can also manually enter the numbers if you wish.

Supervised XE "Supervised" 
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Supervised trunks XE "Supervised trunks"  are marked  
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Unsupervised trunks XE "Unsupervised trunks"  are marked

(Click on the field to change from one to the other.)

Normally, trunks are supervised. If your PABX is an older model, or if your PTT authority does not supply the proper signal on the trunk line to say whether or not a call has connected, then your PABX may not distinguish between connected and unconnected calls. In this case the trunk should be set to Unsupervised and TeleTiger will try to ‘guess’ the connection status based upon duration and digits dialed.

	Caution  If your PABX does not properly report call connection status, then TeleTiger NT can ‘guess’ the status based upon the duration and the number of digits dialed; but remember that this is only a guess and will never be 100% accurate. 

This inaccuracy represents a defect in the PABX and/or trunk line, not in TeleTiger NT. 

The only solution to this problem is to have a PABX that reports connection status properly. Please see Connection status on page 3 for more information.)


L.A.D. XE "L.A.D." 
L.A.D. stands for Line Access Digits XE "Line Access Digits" . Do not worry about this setting unless you have a Northern Telecom XE "Northern Telecom"  Meridian XE "Meridian"  or SL1 XE "SL1"  PABX.

A line access digit is the number (or numbers) you dial to obtain an outside line. For instance you may dial ‘9’ to take the first line available, ‘82’ to take line number 2, or you may simply press a line button to get a line directly, without dialing any extra numbers. 

Most exchanges put the line access digits in a separate field in the SMDR (or do not show them at all). In this case, this field simply contains ‘0’ (zero). However there are a few exchanges (notably the Northern Telecom range) that for some reason add the line access digits to the front of the dialed number. 

Since in this case the line access digits may be 2 characters long on one trunk, 3 characters long on another, and not appear on a third, it is not possible to define any fixed point at which the SMDR data should be cut to obtain the dialed number. 

In the following example, a user has dialed ‘026651904’ on three separate trunk lines. On trunk T001001, he dialed ‘82’ to get a line. On trunk T001002 he dialed ‘9’ to get a line and on trunk T00T003 he took a line directly by pressing a button on the telephone. TTTTTTT is the trunk line and NNNNNNNNNNNNNN is the dialed number.

                 TTTTTTT                      NNNNNNNNNNNNNN
N 033 00 DN1234  T001001 12/01 13:15 00:10:00 82026651904

N 034 00 DN1234  T001002 12/01 13:15 00:10:00 9026651904

N 035 00 DN1234  T001003 12/01 13:15 00:10:00 026651904

If we simply take the data from position NNNNNNNNNNNNNN, then we will not have derived the correct dialed number for lines T001001 and T001002. 

The L.A.D. field contains the number of digits that should be removed from the dialed number in the SMDR line, before processing. 

In the above case, trunk T001001 should be set to a L.A.D. of ‘2’, trunk T001002 should be set to a L.A.D. of ‘1’ and trunk T001003 should be set to a L.A.D. of ‘0’. 

TeleTiger will then remove 2 digits from all numbers dialed on T001001, one digit from T001002 and no digits from T001003, thus deriving the correct dialed number.

Remember that the L.A.D. is the number of digits to be removed, not the digits themselves. If the access code is ‘83’, then you should enter ‘2’ in the L.A.D. field, because there are two digits. (Do not enter ‘83’, or TeleTiger will try to remove the first eighty-three digits from the dialed number!)

	Tip.  For 99% of PABX’s, the L.A.D. field should be set to ‘0’ for all trunk lines. This also includes some Northern Telecom PABX’s. Even if the value is incorrectly set, you can always reprocess the raw SMDR data (which TeleTiger stores) once the correct setting has been determined.


PTT Number XE "PTT Number" 
This is the PTT number relating to the trunk. For example the trunk line reported in the SMDR as trunk line number ‘03’ might be numbered 6651904 by the PTT. Since this is not reported in the SMDR, TeleTiger looks it up in this table.

Trunks to ignore XE "Trunks to ignore" 
TeleTiger NT can be configured to ignore certain trunk lines or extensions. 

A company president may wish to monitor and control telephone use within his company, but might not want information about the use of his personal telephone extension or dedicated trunk line to be recorded.
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The first thing TeleTiger does with an SMDR record is to look up the trunk line in the Trunks to Ignore look-up table and the physical extension in the Physical extensions to ignore look-up table. If the call is found in either table, then no further action is taken and the call is not processed — however the raw SMDR data is retained.

Trunk XE "Trunk" 
Place the number of any trunk you wish to be ignored in this table. 

Note that if a conference call is made involving a trunk in this table and another normal trunk, then the entire call will be ignored 

Extension numbers used only with this trunk do not count towards your licensed total of number of extensions.

Options XE "Options" 
Various TeleTiger settings and configuration items can be defined or modified from the Options window.

 How to open the Options window XE "How to open the Options window" 
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Select Options from the Tools menu

2. The Options window appears

3. Click on the required tab at the top of the Options window.

Any values that you change in the Options window (apart from table-based security or file options) are not applied to the system until you press the OK button. 

To exit from the Options window without applying your settings, press the Cancel button.

If you want to apply your changes without closing the Options window (for example to test their effect), press the Apply button.

General XE "General" 
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This page of the Options window is used to configure general options. 

This PC will process raw data XE "raw data" 

 XE "This PC will process raw data" 
This box should be checked if the PC is connected to a PABX and will process data. 

If the PC is not connected to a PABX and is just used to configure TeleTiger and print reports, then the box should not be checked.

Process data every 4 seconds XE "Process data every 4 seconds" 
TeleTiger usually checks to see if there is any new data for processing every 4 seconds. 

You can change this time if you wish. 

Retry failed operations XE "failed operations"  automatically XE "Retry failed operations automatically" 
If TeleTiger tries to do something and fails (for instance it tries to connect to a database on a server and finds the network connection is not working) it will present an error message box allowing you to Retry  (and other options). 

It is possible that this problem may have occurred whilst TeleTiger was unattended and there is no one there to see the error message or press the Retry button. 

If you have checked this box, TeleTiger will automatically press the Retry button for you every few seconds. 

If the problem goes away (for instance a server that was turned off is turned on again) then the situation is restored without user intervention and the error message disappears automatically.

If you would rather see any error that occurs and clear it manually, then do not check this box

Retry failed operations automatically after 10 seconds XE "Retry failed operations automatically after 10 seconds" 
TeleTiger normally retries failed operations every 10 seconds, but you can change this time here if you wish.

Log unconnected calls XE "Log unconnected calls" 
Unconnected calls are not generally placed in the main database, although the raw SMDR data for them is retained. 

If you want to place unconnected calls in the main database for any reason, then check this box. 

The calls will be placed in the database, but cost will always be set to zero. 

Unconnected calls will not generally appear in reports (unless you have configured a report specifically to show them).

Use PC time/date XE "PC time/date"  to date calls XE "Use PC time/date to date calls" 
Normally, the time and date of calls is determined from the time (and usually the date) reported by the PABX in the SMDR record. 

If you wish, you can use the time and date of the PC to date calls and ignore the time and date from the PABX. One good reason for doing this would be if the PABX was not millennium compliant XE "millennium compliant"  (‘Y2K XE "Y2K"  compliant’ or ‘year 2000 ready’ XE "2000 ready" ) and gave inaccurate dates after 1 Jan, 1999, or failed to operate and had to have its date set back to an earlier year.

	Caution Using the time and date of the PC may not be as precise as using the time and date from the PABX. 

If the PC time is used, then the time at which the SMDR record is received by the PC is taken to be the end time and the duration of the call is deducted from it to deduce the start time. This is only accurate if the SMDR record is received by the PC at about the time at which the call ends. 

If the call has been buffered in the PABX for a long time (some PABX’s wait until they have five or ten calls in the buffer, then send them all at once), then this will of course introduce errors in the start time of the call. 

Usually this is not a serious problem, but if calls are very near to the boundary between full-rate and off-peak periods, there may be charging errors introduced. 

However if your PABX is defective, this may be your only option other than replacing it with a millennium compliant model.


Users XE "Users" 
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This page of the Options window is used to add, delete and configure users of the system. You only need to configure users if you are using Security. If security is turned-off, then users do not need to log-on or be configured.

User XE "User" 
Select the user you wish to administer from this list. 

If TeleTiger is newly installed, then the Administrator may be the only user configured.

Add

Used to add a new user XE "add a new user" .

 How to add a new user XE "How to add a new user" 
1. Select Options from the Tools menu

2. Select the Users page of the Option window

3. Press the Add button on the Users page of the Options window 

4. The New User window appears
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5. Type in the name of the new user in the User box.

6. You can optionally type a Password XE "Password"  for the new user (and confirm it)

7. Click on the Add button.

8. The window stays active, in case you are adding a number of users at the same time. When you have finished, click on the Cancel button.

	Tip.  TeleTiger automatically fills in the Password and Confirm password fields as you type the user’s name. 

By default the new password is the same as the user’s name and should be changed by him the first time he logs-on. 

This feature is useful if you are entering a lot of users at the same time and do not want to have to think-up and remember a lot of different passwords.


Delete

This button is used to delete an existing user XE "delete an existing user" 
 How to delete an existing User XE "How to delete an existing User" 
1. Select Options from the Tools menu

2. Select the Users page of the Option window

	Note.  If you have given non-Administrators access to this module, they will only be able to see users with security levels lower than their own. The Administrator account and the accounts of users at the same or higher security levels will be hidden from them.


3. Select the user you wish to delete from the User list

4. Press the Delete XE "Delete"  button
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A confirmation window appears

6. Click on Yes to delete or No to retain the user.

	Note.  For obvious reasons, you can not delete the Administrator account.
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Password XE "Password"  

Used to change a User's password.

 How to change a User’s password XE "change a User’s password" 

 XE "How to change a User’s password" 
1. Select Options from the Tools menu

2. Select the Users page of the Option window

3. Select the user from the User list

	Note.  If you have given non-Administrators access to this module, they will only be able to see users with security levels lower than their own. The Administrator account and the accounts of users at the same or higher security levels will be hidden from them.
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4. Click on 

5. [image: image161.png]


A password window appears.

6. Enter the password in the New Password text box.

7. Enter the password again in the New Password Again text box to confirm that you did not make any typing errors.

8. Press OK.
	Caution  Make sure that your keyboard is switched to the correct language. If you have configured TeleTiger to hide passwords, then you will not be able to see what you are typing. If you think you are typing a password in English, when your keyboard is actually set to Arabic, you may inadvertently enter a password in Arabic text and have a problem the next time you try to log-on with the keyboard set to English.


Can change password XE "change password" 

 XE "Can change password" 
This check box determines whether or not a User can change his password, or whether he must always use the one supplied by the Administrator.

 How to stop a User from changing his password XE "password" 

 XE "How to stop a User from changing his password" 
1. Select Options from the Tools menu

2. Select the Users page of the Option window

3. Select the user from the User list

	Note.  If you have given non-Administrators access to this module, they will only be able to see users with security levels lower than their own. The Administrator account and the accounts of users at the same or higher security levels will be hidden from them.


4. Uncheck the checkbox Can Change Password.

	Note.  For obvious reasons, you can not remove this right from the Administrator. (Because there is no higher authority, no one would have the authority to give this right back to the Administrator.)


Blank Password XE "Blank Password"  Allowed XE "Blank Password Allowed" 
This check box determines whether or not a user who can change his password is allowed to use a blank password. If a blank password is used, then this user (or anybody else who knows his log-on name!) can log-on without entering any password, simply by pressing the OK button of the Log-on window.

 How to stop Users from entering blank passwords XE "How to stop Users from entering blank passwords" 
1. Select Options from the Tools menu

2. Select the Users page of the Option window

3. Select the user from the User list

	Note.  If you have given non-Administrators access to this module, they will only be able to see users with security levels lower than their own. The Administrator account and the accounts of users at the same or higher security levels will be hidden from them.


4. Uncheck the checkbox Blank Password Allowed
	Note.  For obvious reasons, you can not remove this right from the Administrator. (Because there is no higher authority, no one would have the authority to give this right back to the Administrator.)


Security level XE "Security level" 
This value determines the security level of the user. 

A user’s security level is used to control which areas and modules of the program the user is allowed to access. It also determines a User’s right to modify data. A user might, for instance, have a high enough security level to look at the values in the Rates table, but not a high enough security level to change them.

 How to change a User’s security level XE "change a User’s security level" 

 XE "User’s security level" : XE "How to change a User’s security level\:" 
1. Select Options from the Tools menu

2. Select the Users page of the Option window

3. Select the user from the User list

	Note.  If you have given non-Administrators access to this module, they will only be able to see users with security levels lower than their own. The Administrator account and the accounts of users at the same or higher security levels will be hidden from them.


5. Select the required security level from the list.

	Notes If you have given non-Administrators access to this module, they will only be able to set security levels lower than their own level.

For obvious reasons, you can not reduce the security level of the Administrator. (Because there is no higher authority, no one would have the authority to increase it again.)


Security XE "Security" 
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This page of the Options window is used to configure how security is used  to control access to various parts of the system. 

Enable Security

This checkbox determines whether or not security is used at all. 

 If it is checked, then security is enabled and all access to the different parts of the program will be controlled by the security system.

 If it is not checked, then no security features will be enabled and all users will be able to have free access to any part of the system.

 How to Enable Security XE "Enable Security" 

 XE "How to Enable Security" 
1. Select Options from the Tools menu

2. Select the Security page of the Option window

3. Check the Enable Security check box.

4. Click on Apply or OK.

	Notes  Where there are multiple users of the system, particularly where some of them may be less skilled or have malicious intent, then security should of course be enabled. If there is only a single user and the PC is in a physically secure place, then turning security off saves you the trouble of logging-on each time you want to use the system.

If you have more than one PC connected to the system, remember that security enablement is applied on a PC by PC basis. If you enable or disable security, you have done it only for that one PC that you are using. (However the names and security levels of Users are stored in the central database, so changing a User’s rights affects all PC’s.)


Show Passwords XE "Passwords" 

 XE "Show Passwords" 
This checkbox determines whether or not passwords are shown. 

 If it is checked, then you (and anyone looking over your shoulder!) will be able to see the letters in a password as it is typed. 

 If it is not checked, then the asterisk ( *) character will be shown in place of password characters as they are typed. How to Enable Security

 How to show passwords in plain text XE "passwords in plain text" 

 XE "How to show passwords in plain text" 
1. Select Options from the Tools menu

2. Select the Security page of the Option window

3. Check the Show Passwords check box.

4. Click on Apply or OK.

	Note  For security reasons, it is better not to show passwords; however if your Users are easily confused by having the keyboard set to the wrong language (so that they are not actually typing the password that they think they are) then you might want to show passwords in plain text, at least during the training period.


Passwords case sensitive XE "case sensitive" 

 XE "Passwords case sensitive" 
This checkbox determines whether or not passwords are case sensitive. 

 If it is checked, then you must type a password in the correct case, e.g. if your password is  “MaNaGeR”, then you must type “MaNaGeR” exactly. If you type “Manager”, “MANAGER” or “manager”, then your log-on will be rejected.

 If it is not checked, then you may type a password in any variety of upper or lower case, e.g. if your password is  “MaNaGeR”, then if you type “MaNaGeR”, “Manager”, “MANAGER” or “manager”, your log-on will be accepted..

 How to make passwords case sensitive XE "How to make passwords case sensitive" 
1. Select Options from the Tools menu

2. Select the Security page of the Option window

3. Check the Passwords case-sensitive check box.

4. Click on Apply or OK.

	Notes  For security reasons, it is better to have case sensitive passwords as there are more possible combinations a potential hacker has to guess; however if your Users are easily confused by upper and lower case (so that they are not actually typing the password that they think they are) then you might want to make passwords case insensitive, at least during the training period.

Case sensitivity applies only to passwords in the English language. Arabic has no equivalent upper and lower case, so this setting is ignored for the purposes of Arabic passwords.


Security level XE "Security level" 
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This table is used to control the level of security a user must have in order to enter certain parts of the program.

Name XE "Name" 
This is the name of the module to which access is to be controlled.

Read access XE "Read access" 
This is the security level a user must have in order to enter the module at all.

Write access XE "Write access" 
This is the security level a user must have in order to enter the module and add, change or delete the data in the module. 

 How to change the security level of a module XE "security level of a module" 

 XE "How to change the security level of a module" 
1. Select Options from the Tools menu

2. Select the Security page of the Option window

3. Click on the Read access or Write access field for the module concerned.

4.  Type in the new required value.

5. Move to a different line or exit the table to save the change.

	Notes  For modules where the terms read access and write access are inappropriate, (for instance starting or stopping data processing), the two security values should be the same. If not, then the lower of the two will grant the right.


File Locations XE "File Locations" 
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These settings control where on the PC or network TeleTiger will look for the various files that it needs.

Database location XE "location" 

 XE "Database location" 
This is the location of the main database. In a single PC installation, it will normally be in the same directory as the TeleTiger program itself, however on a network it may be on a network server or another PC.

 How to change the location of the Main Database XE "Main Database" 

 XE "location of the Main Database" 

 XE "How to change the location of the Main Database" 
1. Select Options from the Tools menu

2. Select the File locations page of the Option window

3. Type in the new database location

OR

 Click on Browse, select the database location from the Browse window and click OK.
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	Tip  TeleTiger will not start to use the new database location until you stop and re-start it. 

If a database already exists at the location you have defined, then TeleTiger will begin to use it. 

If a database does not exist there, then TeleTiger will ask you if you want to create one there. 

If you select Yes, then the new database will be created and used. 

If you select No, then TeleTiger will not be connected to a database and will ask you if you want to create a database at the defined location every time you or TeleTiger takes some action that needs a database. (You can still redefine the database location at this time from Database Location module if the location you have previously defined is incorrect.)


Buffer file XE "Buffer file"  name XE "Buffer file name" 
This is the name of the buffer file that holds the raw SMDR data XE "raw SMDR data"  received from the PABX. Port buffer writes the raw data it receives to this file. TeleTiger NT needs to be able to find this file so that it can take the SMDR data.

Note that this file might not actually exist at any given time. If TeleTiger has taken all of the data from the file and processed it, it will delete it. (The raw SMDR has been transferred to the main database by this point) If Port Buffer receives any new data it will create a new file, but it might not have done so yet, so you may find the file does not exist at this time.

The name and location given for this file must match the name and location given in the Port Buffer program.

If this PC is not connected to a PABX and is only used to configure TeleTiger or print reports, then you do not need to define a buffer file name as it will not be used.

  How to change the Buffer file name XE "Buffer file name" 

 XE "change the Buffer file name" 

 XE "How to change the Buffer file name" 
1. Select Options from the Tools menu

2. Select the File locations page of the Option window

3. Type in the new Buffer file name.

 OR

 [image: image166.bmp]Click on Browse, select the buffer file location from the Browse window, type in the name  and click OK.

	Tip  Do not put the buffer file on a network drive. Put it on a drive that is physically on the PC that is connected to the PABX. If you put the Buffer file on a network drive, then if the network is temporarily disconnected or faulty, Port Buffer will have nowhere to put the data and must buffer it in memory (or a virtual memory file), perhaps leading to an overflow and subsequent data loss.


File sizes XE "File sizes" 
It is derivable to place some limitation on the size of the files used by TeleTiger for the following reasons:

1. Although modern hard disks are large, they are not of infinite size. If data is added to a file on a daily basis, forever, then there will be a point at some time in the future at which the hard-drive becomes full, perhaps causing the loss of incoming data or interfering with other functions of the PC

2. The larger a database is, then generally the slower it will be to respond and the longer it will take to locate or retrieve data. Although modern PC’s and database techniques are very fast, there is no need to load them down unnecessarily by keeping many years of old data that could easily be discarded.

3. If the database is on a server, then there are likely to be other programs and databases on it that have to compete for the same space. Even if speed and file-size are not a problem for TeleTiger, you may want to limit how much disk-space TeleTiger can use, so that it does not use up free-space that you want to leave available for other purposes.
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Name XE "Name" 
The name of the table whose file size you wish to control

Days XE "Days" 
The number of days for which you want to retain data. Any data that is older than the number of days shown will be automatically deleted.

Records XE "Records" 
The maximum number of records permitted in the table. If the maximum record size is reached, then when a new record has to be written to the table, the oldest record is overwritten.

	Note  Records that are older than the permitted number of days are deleted at midnight. If the program is not running at midnight, then they are deleted the next time the program is started.


 How to control the maximum size of the database XE "database" 

 XE "size of the database" 

 XE "maximum size of the database" 

 XE "How to control the maximum size of the database" 
1. Select Options from the Tools menu

2. Select the File Sizes page of the Option window

3. Click on the Days or Records field for the table concerned.

4. Type in the new required value.

5. Move to a different line or exit the table to save the change.

	Notes  Only tables that are likely to increase steadily in size are controlled from here. Tables that are of relatively static size, for instance the Rates table, do not need to be controlled.


U.D.F. XE "U.D.F."  (User Defined Fields XE "User Defined Fields" )
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The Charge Points table contains a multi-use additional field that you can use for any purpose you wish. The default name of this field is ‘Section’ XE "Section’" . If you want to use this field for some purpose other that the section to which the Charge Point belongs, you may do so. You can change the name of the field here.

 To change the name of the User Defined Field XE "User Defined Field" 

 XE "name of the User Defined Field" 

 XE "To change the name of the User Defined Field" 
1. Select Options from the Tools menu

2. Select the UDF page of the Option window

3. Type in the new name of the field.

4. Click on OK or Apply to save the change.

	Notes  Only the name displayed over the field is changed. The underlying name of the field in the database remains the same, so that any external or third-party program that needs to access the data directly, does not need to be reconfigured.

The name that you have changed from here is the English name for the field. There is a separate but corresponding Arabic name for the field that can be changed in similar manner, when the screen language of the program is se to Arabic.


Chapter 5 — Reporting
Reporting XE "Reporting" 
Generating reports XE "Generating reports" 
Most of the information that you get from TeleTiger will be in the form of reports. A report consists of a selection of records from the database, arranged in a particular manner and according to a particular layout. When you generate a report, you can view it on the computer screen, print it, or both.

Filtering records XE "Filtering records" 
When you generate a report, you usually do not want to have all of the records in the database in the report. Usually you will want to select records that fall within a certain time period. Additionally, you may want to select records from only one sub-group of data, perhaps the records of one or more Departments or Cost Centers, or perhaps only International calls. This selection process is known as filtering.

Report format XE "Filtering records" 
After you have set the filters to select which records you want in a report, you then select the report format. Report format controls how the data is laid out on the page of the printed report.

The Reports window XE "The Reports window" 
Most reporting functions are carried out via the Reports window. This window carries controls that make it easy to select the period of the report, the items to be included in the report and the specific report layout to be used.

 How to make the Reports window XE "Reports window"  appear XE "How to make the Reports window appear" 
1. Select the Reports menu

Or

Click on

2. The Reports window appears
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Selecting the period XE "Selecting the period" 
You will normally want to select records from within a certain period. This is done by defining the Start time XE "Start time"  and End time XE "End time"  of the period for which you want a report. 

Normally, you will define only the dates for the Start time and End time of a report. The default Times of 00:00:00 and 23:59:59 will give you whole days for the period you have chosen, but you can modify them if you wish, to produce reports for periods that start or end in the middle of a day.

There are several different ways of selecting the period and you can use whichever one you prefer.

Entering the period directly XE "Entering the period directly" 
The simplest way to define the period is simply to type the times and dates into the appropriate boxes directly:
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Remember that both the display format of the dates and the format in which you should type the new date are the Windows default formats as defined on your PC. (If you would like to change this format, see your Windows documentation, or the Windows Help system for details.)

Using a period selection button XE "Using a period selection button" 
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One of the quickest ways to select a period is to use the period selection buttons:

Clicking one of the period selection buttons in the central row selects a predefined period in accordance with the following table:

	Button
	Action

	[image: image64.bmp]
	Yesterday XE "Yesterday" 

	[image: image65.bmp]
	Last week XE "Last week" 

	[image: image66.bmp]
	Last month XE "Last month" 

	[image: image67.bmp]
	Last quarter XE "Last quarter" 


	Note  If you have set the system to use Hijri dates, then the Last month and Last quarter buttons will select the last Hijri month or quarter. 


Each of the period selection buttons has a button above and below it. You can move backwards and forwards by the corresponding period by clicking on one of these buttons.
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Example: To select the month before last, click on the Last month button, then click on the button above it. You have selected the period you want with only two mouse clicks!

Using the date spinners XE "date spinners" 

 XE "Using the date spinners" 
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You can increase or decrease the date of both the Start time and the End time for a report by clicking on the spinner buttons to the left of the appropriate text box. One click advances or retards by one day:

Using the times list XE "times list" 

 XE "Using the times list" 
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You can set the times for the Start time and End time by selecting a time from a list:

Using the Calendar XE "Calendar"  selector XE "Calendar selector" 

 XE "Using the Calendar selector" 
You can set the dates for both Start time and End time using a Calendar selector.

 How to make the Calendar selector appear XE "How to make the Calendar selector appear" 
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Click on the drop box at the right of the appropriate text box

2. The Calendar selector appears

Selecting a date XE "Selecting a date" 
To select a date from the Calendar selector, simply click on it. The date will be entered in the appropriate text box and the Calendar selector will close automatically.

Selecting a range of dates XE "Selecting a range of dates" 
You can select a range of dates (i.e. a start date and an end date) in one operation, using the Calendar selector from either the Start time or End time date boxes.

 How to select a range of dates XE "dates" 

 XE "range of dates"  using the Calendar selector XE "select a range of dates using the Calendar selector" 

 XE "How to select a range of dates using the Calendar selector" 
1. Place the mouse pointer over the first date in the period

2. Press down the left mouse button and hold it down.

3. Move the mouse to position the cursor over the required end date

4. Release the mouse

5. The start and end dates are automatically entered into the appropriate text boxes and the Calendar control closes.

Changing the month shown in the Calendar selector XE "Changing the month shown in the Calendar selector" 
By default the Calendar selector shows the current month, with today’s date highlighted in red. There are a number of ways of changing to another month.

 How to change the month shown in the Calendar selector XE "month shown in the Calendar selector" 
 Click on the button at the left to go back one month

Or

 Click on the button at the right to go forward one month.

Or

 Select a month from the Months drop list


Or

 Select a year from the Years drop list

Or

 Select the month using the period selector buttons, before using the Calendar selector.

	Tips  If you want to select a single day, then double-click it in either Calendar selector to set both Start time and End time automatically.


Selecting the records XE "Selecting the records" 
If you want a report that shows all calls for the period selected, then you can skip this stage. However, if you want to select only certain calls that fall within the period, for instance calls from a single Charge Point or Department, then you can do this by setting certain values in the Filter XE "Filter"  section of the Reports window.


The Filter section contains drop lists that let you filter a report on Charge Point, Section (UDF), Department, Physical Extension, Identity, Trunk, Number, Location, Type or any combination of these. For instance, you could select only the calls made to the USA by Charge points in the Sales department using trunk line number 03 in November.

How to produce a report filtered by Charge Point XE "filtered by Charge Point" 

 XE "Charge Point" 

 XE "report filtered by Charge Point" 

 XE "How to produce a report filtered by Charge Point" 
 For a single Charge Point, type in its value directly in the Charge Point text box.

Or

1. Click on the drop-list arrow to the right of the Charge Point text box.

2. A drop-list showing the available Charge points appears.

3. Check the box at the left of the Charge point or Charge points that you want to appear in the report. 

Check (All) if you want all Charge points to appear in the report. 

(The list will retract automatically if you go to another control, or if you click anywhere on the window.)

	Note  If you have selected anything other than (All) in the Section field or the Department field, then you will only be able to see the Charge Points have a matching Section or Department.


How to produce a report filtered by Section XE "Section" 

 XE "filtered by Section" 

 XE "report filtered by Section" 

 XE "How to produce a report filtered by Section" 
(If you have changed the name of the User Defined Field, then you may have a name other than ‘Section’ here.)

 For a single Section, type in its value directly in the Section text box.

Or

1. Click on the drop-list arrow to the right of the Section text box.

2. A drop-list showing the available Sections appears.


3. Check the box at the left of the Section or Sections that you want to appear in the report. 

Check (All) if you want all Sections to appear in the report. 

(The list will retract automatically if you go to another control, or if you click anywhere on the window.)

	Note  If you select anything other than (All) , then in the Charge Points list you will only be able to see the Charge Points have a matching Section.


How to produce a report filtered by Department XE "filtered by Department" 

 XE "report filtered by Department" 

 XE "How to produce a report filtered by Department"  

 For a single Department, type in its value directly in the Department text box.

Or

1. Click on the drop-list arrow to the right of the Department text box.

2. A drop-list showing the available Departments appears.

3. Check the box at the left of the Department or Departments that you want to appear in the report. 

Check (All) if you want all Departments to appear in the report. 

(The list will retract automatically if you go to another control, or if you click anywhere on the window.)

	Note  If you select anything other than (All) , then in the Charge Points list you will only be able to see the Charge Points have a matching Department.


How to produce a report filtered by Physical extension XE "Physical extension" 

 XE "filtered by Physical extension" 

 XE "report filtered by Physical extension" 

 XE "How to produce a report filtered by Physical extension" 
 For a single Physical extension, type in its value directly in the Physical extension text box.

Or

1. Click on the drop-list arrow to the right of the Physical extension text box.

2. A drop-list showing the available Physical extensions appears.

3. Check the box at the left of the Physical extension or Physical extensions that you want to appear in the report. 

Check (All) if you want all Physical extensions to appear in the report. 

(The list will retract automatically if you go to another control, or if you click anywhere on the window.)

How to produce a report filtered by Identity XE "Identity" 

 XE "filtered by Identity" 

 XE "report filtered by Identity" 

 XE "How to produce a report filtered by Identity" 
 For a single Identity, type in its value directly in the Identity text box.

Or

1. Click on the drop-list arrow to the right of the Identity text box.

2. A drop-list showing the available Identities appears.

3. Check the box at the left of the Identity or Identities that you want to appear in the report. 

Check (All) if you want all Identities to appear in the report. 

Check (Blank) if you want only blank Identities (calls that have not been identified) to appear in the report. 

Check (Not blank) if you want only non-blank Identities (calls that have been identified) to appear in the report. 

(The list will retract automatically if you go to another control, or if you click anywhere on the window.)

How to produce a report filtered by the Trunk line used XE "Trunk line used" 

 XE "filtered by the Trunk line used" 

 XE "report filtered by the Trunk line used" 

 XE "How to produce a report filtered by the Trunk line used" 
 For a single Trunk, type in its value directly in the Trunk text box.

Or

1. Click on the drop-list arrow to the right of the Trunk text box.

2. A drop-list showing the available Trunks appears.

3. Check the box at the left of the Trunk or Trunks that you want to appear in the report. 

Check (All) if you want all Trunks to appear in the report. 

(The list will retract automatically if you go to another control, or if you click anywhere on the window.)

How to produce a report filtered by the Number dialed XE "Number dialed" 

 XE "filtered by the Number dialed" 

 XE "report filtered by the Number dialed" 

 XE "How to produce a report filtered by the Number dialed" 
 Type the value of the number directly in the Number text box.

	Tips  If you later decide you do not want to filter on the dialed number, just delete everything from the Number text box and it will automatically take a value of (All).

You can filter on the start of a dialed number. For instance, if you enter ‘0044’ in the Number text box, then all numbers starting with ‘0044’ will appear in the report.


How to produce a report filtered by the Location dialed

 For a single Location, type in its value directly in the Location text box.

Or

1. Click on the drop-list arrow to the right of the Location text box.

2. A drop-list showing the available Locations appears.


3. Check the box at the left of the Location or Locations that you want to appear in the report. 

Check (All) if you want all Locations to appear in the report. 

(The list will retract automatically if you go to another control, or if you click anywhere on the window.)

How to produce a report filtered by the Type of call XE "filtered by the Type of call" 

 XE "report filtered by the Type of call" 

 XE "How to produce a report filtered by the Type of call" 
 For a single Type, type in its value directly in the Type text box.

Or

1. Click on the drop-list arrow to the right of the Type text box.

2. A drop-list showing the available Types appears.

3. Check the box at the left of the Type or Types that you want to appear in the report. 

Check (All) if you want all Types to appear in the report. 

(The list will retract automatically if you go to another control, or if you click anywhere on the window.)

Quick filters XE "Quick filters" 
In addition to the powerful and flexible filters shown above, TeleTiger has a number of Quick filters for your day-to-day filtering of routine reports. 
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Unlike the standard filters, the Quick filter settings are remembered. Whatever you configure here will still be the same the next time you open the Reports window.

Exclude incoming calls XE "incoming calls" 

 XE "Exclude incoming calls" 
Incoming calls (if any) will not appear in the report.

Exclude local calls XE "local calls" 

 XE "Exclude local calls" 
Local calls (if any) will not appear in the report.

Exclude internal calls XE "local calls" 

 XE "Exclude local calls" 
Internal extension-to-extension calls (if any) will not appear in the report.

Exclude calls XE "cheap calls" 

 XE "Exclude cheap calls"  costing less than…
Any call with a chargeable value of less than the value specified will not appear in the report. The value can be changed using the spinner buttons.
Selecting the report format XE "report format" 

 XE "Selecting the report format" 
The report format determines how the report will look on the printed page. It is not related to the filtering process above. For instance, if you set the filter to exclude local calls, then you chose a report format that has a column for local calls, then that column will still appear (although it will only contain zero or blank values).

Each report format is in a separate file. These files have an extension of .rpt so that a report format called (for example) My Report Format would be stored in a separate file on your hard-disk called My Report Format.rpt.

TeleTiger is supplied with a comprehensive number of reports, but if you wish you can write your own (or copy and modify the ones supplied with TeleTiger). You may for instance want to add a company logo to a report, or change the alignment or configuration.

All report formats are in Seagate Crystal Reports XE "Crystal Reports" 

 XE "Seagate Crystal Reports"  format and you will need a copy of Crystal Reports if you plan to modify or create reports.

	Tip  Most TeleTiger dealers can sell you a copy of Crystal Reports and can modify your reports for you (or arrange for this to be done by a third party).


 How to select the report format XE "report format" 

 XE "How to select the report format" 
1. Click on the drop list button to the right of the Report to Print list

2. A list of available report formats appears

3. Select the required report from the list

Generating a Report XE "Generating a Report" 
Before displaying a report, you should first select the required period, required records and the required format in accordance with the sections above.

 How to generate a report XE "How to generate a report" 
1. Select the Report menu item, or click on 

2. Select the period required in accordance with the section Selecting the Period on page 3 .

3. Select the records required in accordance with the section Selecting the Records on page 3.

4. Select the report format required in accordance with the section Selecting the Report Format on page 3.

5. Click on the OK button.

6. TeleTiger first loads the report format. The words Loading report… appear on the Toolbar whilst this is happening. 

7. TeleTiger next requests the required records from the database. The word Busy… appears on the Toolbar whilst this is happening. 

8. TeleTiger next adds the required records to the report as they are received from the database. A counter showing the number of records loaded appears on the Toolbar whilst this is happening. 

9. TeleTiger completes the report and the finished report appears on the screen.


	Tip  If you start to generate the wrong type of report by mistake, you can stop report generation by clicking on [image: image69.bmp]


Handling reports XE "Handling reports" 
You can move backwards and forwards through a report and perform other report-related functions by using the report control buttons on the toolbar.

The report control buttons work in accordance with the following table:

	Button
	Action

	[image: image70.bmp]
	Go to the first page XE "first page"  of a report.

	[image: image71.bmp]
	Go to the previous page XE "previous page"  of a report.

	[image: image72.bmp]
	Go to the next page XE "next page"  of a report.

	[image: image73.bmp]
	Go to the last page XE "last page"  of a report.

	[image: image74.bmp]
	Stop generating the report XE "Stop generating the report" 

	[image: image75.bmp]
	Zoom the report. XE "Zoom the report."  (Change report magnification XE "magnification" 

 XE "report magnification" . XE "Change report magnification." )

	[image: image76.bmp]
	Print XE "Print"  the report XE "Print the report" .
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